Click this to select the number you want to dial from your WinFax phonebooks.



Type the local number you dial when calling the recipient. You can use hyphens, spaces or no separators.



Click this to select the number you want to dial from your WinFax phonebooks.



Click this to start recording.



Click this to stop recording or playback.



Click this to play your recording.



Click this to delete the current message.



Click this to play the messages in the active mailbox. The Answering Machine plays the new messages first, then the old messages.



Click this to rewind the message four seconds.



Click this to go to the next message.



Click this to stop message playback.



Click this to record a memo in the active mailbox.



Click this to record a new greeting for the active mailbox.



Adjust the slide control to the appropriate volume.



Adjust the slide control to move to the part of the message you want to hear.



Adjust the message playback speed.



Displays the active mailbox. To switch to another mailbox, click it in the drop-down list.



Click this to go to the previous message.



Click this to fast forward the message four seconds.



Slide the control to adjust the Telephone volume.



Displays the number of new messages in the active mailbox.



Displays the number of old messages in the active mailbox. Old messages are messages you have already reviewed, but not
deleted from the mailbox.



Displays the current time. During message playback, message information including the message type (new or old), length, and the
date and time it was received appears in the display area.



Type the area code or city code you dial when calling the recipient. For overseas destinations, type the routing code, if applicable.



Type the country code you dial when calling the recipient. TalkWorks uses the country code to identify international destinations
when you are dialing overseas.



Displays a list of the most recent numbers you dialed using the Telephone. Click the number you want to dial.



Click this to display a menu from which you can enable or disable Automatic Receive, run the Mailbox wizard, change TalkWorks
properties or close the Answering Machine.



Click this to display a menu from which you can expand (or collapse) the speed dial panel of the Telephone, change Telephone
setup or close the Telephone.



Enable this option if you want the Telephone to automatically redial the number if the line is busy.



Moves the Answering Machine to a different location on the screen.



Maximizes the Answering Machine to full display, when it has been minimized.



Minimizes the Answering Machine to a button on the Windows Taskbar.



Closes the Answering Machine.



Enables automatic fax and voice message reception. You can only receive voice messages with TalkWorks when this command is
enabled.



Displays the properties of the Answering Machine.



About command



Maximizes the Telephone to full display, when it has been minimized.



Moves the Telephone to a different location on the screen.



Minimizes the Telephone to a button on the Windows Taskbar.



Closes the Telephone.



Enables automatic fax and voice message reception. You can only receive voice messages with TalkWorks when this command is
enabled.



Displays the properties of the Telephone.



About command



Expands or collapses the speed dial panel of the Telephone.



Click this to play your recording.



Click this to stop recording or playback.



Click this to start recording.



Click this to go to the previous message.



Click this to record a memo in the active mailbox.



Click this to rewind the message four seconds.



Click this to fast forward the message four seconds.



Adjust the slide control to move to the part of the message you want to hear.



Adjust the speed at which the Answering Machine plays back messages.



Click this to delete the current message.



Adjust the slide control to the appropriate volume.



Click this to record a greeting for the active mailbox.



Click this if you want callers to be able to leave a message in this mailbox.



Click this if you want TalkWorks to play an announcement to the caller when they access this mailbox and then hang up. The caller
cannot leave a message.

Use this option to dispense standard information frequently requested by your callers. For example, you might use an
announcement mailbox to provide your current mailing address and fax number to callers.



Type the two digit password you want to use to access this mailbox remotely.

Use this password to retrieve messages and record your mailbox greeting from any touch tone telephone.



Click this if you do not want to be able to access this mailbox remotely. If you enable this option, the mailbox owner can only retrieve
their messages from the Answering Machine or the WinFax Receive Log.



Click this if you want to be able to access this mailbox remotely from any touch tone telephone.

When you enable this option, you can re-record mailbox greetings, retrieve voice messages and change your password from any
touch tone telephone.



Click this if you want TalkWorks to automatically direct all calls to a single mailbox. TalkWorks takes messages without asking the
caller which mailbox they want to leave their message in and saves the messages in the WinFax Receive Log.



Click this if you want TalkWorks to prompt the caller to enter the number of the mailbox they want to leave a message in. TalkWorks
saves messages in the corresponding mailbox folder in the WinFax Logs window. Use this option for a multiple mailbox system.



Click this if you want TalkWorks to use the standard “Please enter a mailbox number now” message.



Click this if you want to record a custom mailbox menu.

Use this option if you want to give the caller more explicit instructions. For example, “To leave a message for James Smith, press
11; to leave a message for Lisa MacDonald, press 12”



Select a unique access number in the drop-down list. Numbers already assigned do not appear in the list. The length of numbers is
determined by the number length you specified.

If you are creating a mailbox, the caller uses this number to specify the mailbox in which they want to leave a message. If you
setting up documents for a fax on demand mailbox, the caller uses this number to select this document to be faxed to them.



Click this to disable the active mailbox. If the caller enters the mailbox number for this mailbox, TalkWorks does not allow them to
access the mailbox to leave a message.

If you are going to be away from the office for an extended period of time, use this option to ensure that callers cannot leave

messages in this mailbox. Alternatively, you may want to change the mailbox into an announcement mailbox that directs the caller to
another extension for assistance.



Click this to enable access to this mailbox.



Type the name of the mailbox in the field.



Click this to use one of the prerecorded greetings provided with TalkWorks.

In TalkWorks, there are three types of greetings: a system greeting (the greeting TalkWorks uses to answer the telephone), a
mailbox greeting and an announcement.



Click this to record a custom greeting or to import a greeting you previously recorded.

In TalkWorks, there are three types of greetings: a system greeting (the greeting TalkWorks uses to answer the telephone), a
mailbox greeting and an announcement.



Use the TalkWorks Mailbox wizard to set up your voice mailbox system.
Follow the instructions provided on screen.
If you need help on an item in a panel, select the item and press F1.

Step-by-step procedures and recording tips are available in the “Use TalkWorks Voice Messaging and Telephony Features” section
of the WinFax online help. If you have not already reviewed the help, exit the Mailbox wizard, read the online help and then start the
wizard when you are ready to proceed. You may find it useful to print the appropriate topics and keep them for reference while you
are using the wizard.

To display the online help:

1. Exit the Mailbox wizard.

2. On the WinFax Help menu, click WinFax Help Topics. The Help Topics window appears.
3. Double click the How To book.

4. Double click the Use TalkWorks Voice Messaging And Telephony Features book.



Lists the names of all prerecorded greetings included with TalkWorks. The script of the selected greeting appears in the Description
area. Click the greeting you want to use.



Displays a condensed version of the script of the selected greeting.



Set the number of times you want TalkWorks to let the telephone ring before answering it.



Click this if you want TalkWorks to automatically attempt to redial unsuccessful calls for a specific period of time.



Click this if you want TalkWorks to automatically attempt to redial unsuccessful calls a set number of times.



Type the number of minutes for which you want TalkWorks to attempt to redial a call if the line is busy.



Type the number of times you want TalkWorks to attempt to redial a call if the line is busy.



Type the number of seconds for which you want TalkWorks to attempt to redial a call if the line is busy.



Type the number of seconds you want TalkWorks to wait between attempted redials.



Type the path and file name of the wave file ((WAV) you want TalkWorks to use to announce an incoming call. If you leave this field
blank, TalkWorks does not announce incoming calls.



Click this to select the wave file (.WAV) you want to use from your computer’s drives and directories.



Type the path and file name of the wave file ((WAV) you want TalkWorks to use to play when a caller is on hold.
You can only put callers on hold if your hardware supports call holding.



Click this to select the wave file (.WAV) you want to use from your computer’s drives and directories.



Starts the TalkWorks Mailbox wizard. Use the wizard to set up new mailboxes and modify the properties of existing mailboxes.



Click this to play the selected greeting.



Click this to stop playing the greeting.



Sorts the list by number.



Sorts the list by name.



Sorts the list by type.



Set the length (in digits) of access numbers.

If you are creating a mailbox, this number is the length of mailbox numbers. If you are setting up documents in a Fax on Demand
mailbox, this number is the length of document numbers.



Click this if you want to create a mailbox in which callers can request documents to be faxed to them by document number.



Click this if you want to create a mailbox to record and store voice messages.



Displays a list of all currently defined mailboxes.



Click this to create a new mailbox.



Deletes the mailbox selected in the mailbox list.



Click this to display the properties of the active mailbox for editing.



Click this to enable or disable the active mailbox or to change the mailbox number.



Displays a list of all currently defined mailboxes and their mailboxes numbers. If a mailbox is disabled, the word “Disabled” appears
in the Box Number column.



Lists all defined fax on demand documents, their descriptions and associated files. A document can consist of a single fax-ready
image file or multiple fax-ready image files. Create fax-ready image files by printing documents to the WinFax printer and then
saving them as attachments.



Click this to add a document to the fax on demand mailbox.



Deletes the selected document. This does not delete the associated fax-ready image files.



Click this to display the properties of the selected document for editing.



Type a name for the document.



Type text to help you identify this document in the future.



Click this to add fax-ready images files to the document.



Select the hardware device you want to use to play voice messages. The items in the list vary depending on the hardware you are
using.



Adjust the slide control to the appropriate volume.



Adjust the slide control to the appropriate volume.



Select the hardware device you want to use to record voice messages. The items in the list vary depending on the hardware you are
using.



Select the hardware device you want to use to record voice messages. The items in the list vary depending on the hardware you are
using.



Adjust the slide control to the appropriate volume.



Adjust the slide control to the appropriate volume.



If you selected a playback or recording device that requires TalkWorks to dial another telephone number, type the number in this
field.



If you selected a playback or recording device that requires TalkWorks use another telephone number, type the number in this field.



Click this button to select the compression method.

TalkWorks uses the speed of your computer to determine whether it compresses voice wave files during or after recording and
playback. TalkWorks detects your processor speed during installation, and sets wave compression accordingly.



Enable this option to use TalkWorks voice answering capabilities.

To use voice answering, you must also enable Auto Receive, either on the WinFax Receive menu or on the menu in the Answering
Machine.



Type the minimum message length (in seconds) in this field. All messages shorter than this length are not recorded. This prevents
TalkWorks from recording messages if the caller hangs up without saying anything.



Type the minimum message length (in seconds) in this field. All messages shorter than this length are not recorded. This prevents
TalkWorks from recording messages if the caller hangs up without saying anything.



Type the minimum message length (in seconds) in this field. All messages shorter than this length are not recorded. This prevents
TalkWorks from recording messages if the caller hangs up without saying anything.



Type the maximum message length (in seconds) in this field.

Use this field to maximize the number of messages your mailbox can hold.



Type the maximum message length (in seconds) in this field.

Use this field to maximize the number of messages your mailbox can hold.



Type the maximum message length (in seconds) in this field.

Use this field to maximize the number of messages your mailbox can hold.



Use this slide control to indicate when you want TalkWorks to stop recording a message.

Set the slide control to Off if you want TalkWorks to continue recording even when it detects a period of silence. If you set the slide
control to any other position, TalkWorks will automatically stop recording when it detects a period of silence during recording. The
slide control position determines how sensitive TalkWorks is to noises when trying to detect periods of silence. If your telephone line
has a lot of background noise, adjust this setting towards the High end of the slide control.



Select the compression level you want to use.

If quality is more important than the size of voice messages, click Best Voice Quality. If disk space or file size is most important, click
Conserve Disk Space.



Select the compression level you want to use.

If quality is more important than the size of voice messages, click Best Voice Quality. If disk space or file size is most important, click
Conserve Disk Space.



Enable this option if you want TalkWorks to announce the time at which messages are left in 24-hour format.

If you disable this option, TalkWorks announces the time messages were left using the 12-hour clock with the appropriate a.m. or
p.m. label.



Select the hardware device you want to use to play voice messages. The items in the list vary depending on the hardware you are
using.



Type the path and file name of the wave file ((WAV) you want TalkWorks to play to announce an incoming call. If you leave this field
blank, TalkWorks does not announce an incoming call.



Click this to select the wave file (.WAV) you want to use from your computer’s drives and directories.



Lists all defined fax on demand documents, their descriptions and associated files. A document can consist of a single fax-ready
image file or multiple fax-ready image files. Create fax-ready image files by printing documents to the WinFax printer and then
saving them as attachments.



Click this to enable and disable remote access for this mailbox and change the document number.



Displays the list of fax-ready image files associated with this document.



Removes the selected fax-ready image file from the document. This does not delete the actual fax image file.



Click this to disable access to this document.

Remember to change the document menu to reflect this change.



Click this to enable access to this document.



Lists a summary of all mailbox options you selected with the Mailbox wizard.

To change any of your selections, click Back repeatedly until you reach the appropriate panel, make the changes and Click Next
repeatedly until you return to this panel.

If you do not need to make changes, click Create.



Lists a summary of all mailbox system options you selected with the Mailbox wizard.

To change any of your selections, click Back repeatedly until you reach the appropriate panel, make the changes and Click Next
repeatedly until you return to this panel.

If you do not need to make changes, click Finish.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the display panel.
When you are done entering the phone number, click Dial to begin dialing the telephone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the display panel.
When you are done entering the phone number, click Dial to begin dialing the telephone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the display panel.
When you are done entering the phone number, click Dial to begin dialing the telephone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the display panel.
When you are done entering the phone number, click Dial to begin dialing the telephone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the display panel.
When you are done entering the phone number, click Dial to begin dialing the telephone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the display panel.
When you are done entering the phone number, click Dial to begin dialing the telephone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the display panel.
When you are done entering the phone number, click Dial to begin dialing the telephone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the display panel.
When you are done entering the phone number, click Dial to begin dialing the telephone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the display panel.
When you are done entering the phone number, click Dial to begin dialing the telephone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the display panel.
When you are done entering the phone number, click Dial to begin dialing the telephone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the display panel.
When you are done entering the phone number, click Dial to begin dialing the telephone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the display panel.
When you are done entering the phone number, click Dial to begin dialing the telephone number.



Click this to dial a telephone number.

If you already keyed in a telephone number, it appears in the display panel and TalkWorks dials that number. Otherwise, a dialog
appears prompting you to specify the number you want to dial.



Click this to redial the last number you dialed with the Telephone.



Click this to disconnect the current call. This clears the connection so you can begin a new call.



Click this to pick up an incoming call if you subscribe to a call waiting service from your local telephone company.



Click this to use the speaker phone to make or answer a call. When you are using the speaker phone, the indicator on the button
appears yellow.



Click this to put the caller on hold.

You can only put callers on hold if your hardware supports call holding.



Click this to block out sound at your end of the call. When this option is enabled, the indicator on the button appears yellow.



Click this to hang up the Telephone and disconnect the current call.



Click this to dial the person listed on the button.



Click this to dial the person listed on the button.



Click this to dial the person listed on the button.



Click this to dial the person listed on the button.



Click this to dial the person listed on the button.



Click this to dial the person listed on the button.



Click this to dial the person listed on the button.



Click this to dial the person listed on the button.



Click this to dial the person listed on the button.



Click this to dial the person listed on the button.



Click this to dial the person listed on the button.



Click this to dial the person listed on the button.



Click this to set up a speed dial for the next speed dial button you click. When you are in setup mode, the indicator on the button
appears yellow.



Click this to redial the last number you dialed with the Telephone if the line is busy.



Click this to display redial properties.



Displays the length of the recording. If this area is empty, TalkWorks does not detect an existing record.



Displays the length of the recording. If this area is empty, TalkWorks does not detect an existing record.



Click this to play all new voice messages in the active mailbox folder.



Click this to play the selected voice message.



Click this to pause message playback.



Click this to stop message playback.



Click this to fast forward the message four seconds.



Click this to rewind the message four seconds.



Click this to go to the previous message.



Click this to go to the next message.



Click this to record a memo in the active mailbox.



Starts TalkWorks AudioEditor and loads the selected voice message for editing.



Adjust the slide control to the appropriate volume.



Adjust the slide control to move to the part of the message you want to hear.



Adjust the slide control to the desired playback speed.



Click this to delete the current message.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



Displays the length of the recording. If this area is empty, TalkWorks does not detect an existing record.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



Specify the greeting you want to use. Record a greeting or import an existing greeting file.



Displays the length of the recording. If this area is empty, TalkWorks does not detect an existing record.



No help topic is associated with this item.



Displays the length of the recording. If this area is empty, TalkWorks does not detect an existing record.



No help topic is associated with this item.



Starts TalkWorks AudioEditor and loads the selected voice message for editing.



Specify the mailbox type.



Specify the remote access password.



Specify how you want TalkWorks to prompt callers to choose a mailbox.



No help topic is associated with this item.



Specify the mailbox name.



No help topic is associated with this item.



Lists a summary of all mailbox system options you selected with the Mailbox wizard.

To change any of your selections, click Back repeatedly until you reach the appropriate panel, make the changes and Click Next
repeatedly until you return to this panel.

If you do not need to make changes, click Finish.



No help topic is associated with this item.



Specify the type of greeting you want to use. You can use a prerecorded TalkWorks greeting or a custom greeting you record.



No help topic is associated with this item.



No help topic is associated with this item.



Select the greeting you want to use.



Set the number of times you want TalkWorks to let the telephone ring before answering it.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



No help topic is associated with this item.



Set the length (in digits) of access numbers.

If you are creating a mailbox, this number is the length of mailbox numbers. If you are setting up documents in a Fax on Demand
mailbox, this number is the length of document numbers.



No help topic is associated with this item.



No help topic is associated with this item.



Type the text you want to appear on the speed dial button. Use a descriptive label to help identify the speed dial button in the future.
Keep the label short to fit on the button.



Lists all defined WinFax phonebooks. To open a phonebook, click it.



Lists all recipients in the selected phonebook.



Click this to select the wave file (.WAV) you want to use from your computer’s drives and directories.



Click this to select the wave file (.WAV) you want to use from your computer’s drives and directories.



Displays the current time, the number being dialed and feedback about the call.



Do not translate this topic. It is for help project administration only.

Telephone Properties dialog - Dialing tab



Lists all defined locations and identifies your current location. WinFax uses your location to determine how to dial calls based on the
information in this dialog. Select the location you want to modify.



Click this to set up a new location and the dialing instructions you want WinFax to use when calling from the new location.



Removes the location selected in the Location drop-down list. You cannot remove the “Default” location.



Type the country code for this location.

WinFax uses the country code to determine how to dial long distance telephone numbers. For example, in North America the
country code is “1”.



Type the area code for this location.

If the number in this field matches the area code identifier on an outgoing telephone call, WinFax does not dial the area code. If the

number in this field does not match the area code on the outgoing call, WinFax recognizes it as a long distance call and dials the
area code.



Type the local telephone number corresponding to the location in the Location drop-down list.



Enable this option if you need to dial a prefix before dialing fax and data numbers from this location.

A dial prefix is a series of up to 24 characters used to get an outside phone line, dialed before the actual telephone number. For
example, with many office phone systems you must dial “9” to get an outside line.



Type the dial prefix in the field or click a previous prefix in the drop-down list.

A dial prefix is a series of up to 24 characters used to get an outside phone line, dialed before the actual telephone number. For
example, with many office phone systems you must dial “9” to get an outside line.

Follow the prefix with either a comma (,) or a “W”. A comma instructs the modem to pause for a length of time before dialing the
number. For most modems, this is two seconds. A “W” instructs the modem to wait until it receives a dial tone.



Enable this option if you need to dial a suffix after dialing telephone numbers from this location.



Type the dial suffix in the field or click a previous suffix in the drop-down list.



Enable this option to bill calls from this location to a credit card.



Specify the credit card to which you want to bill calls from this location.



Enable this check box for pulse dialing from this location.



Type the dial prefix required for long distance calls from this location. For example, in North America, “1” is the code.



Type the dial prefix for international calls from this location. For example, in North America the code is “011”.



Specify the modem you want to use when making calls from this location.



Do not translate this topic. It is for help project administration only.

Telephone Properties dialog - Credit Cards tab



Lists all defined credit cards. Select the credit card you want to modify.



Click this to define a new credit card.



Removes the selected credit card in the list.



Click this to rename the selected credit card in the list.



Type the credit card or calling number against which your faxing charges are to be made. For security, your card number appears on
the screen as asterisks.



Some credit cards, such as Sprint and MCI, require a 1-800 dialing prefix or other number. Type this number in the Service Access
Number field. You can type up to 29 characters.

If your service does not require a dialing prefix, this field does not appear.



Type the long distance access number for this credit card. In North America, the code is usually 0.



Type the international access number for this credit card. In North America, the code is usually 01.



Click this to specify how to dial numbers billed to this credit card. For the listed credit cards, the defaults are appropriate in most
cases.



Do not translate this topic. It is for help project administration only.

Telephone Properties dialog - Dialing tab - New Location dialog



Type the name of the new location you want to create.



Do not translate this topic. It is for help project administration only.

Telephone Properties dialog - Credit Cards tab - New Credit Card dialog



Type the name of the new credit card.



Do not translate this topic. It is for help project administration only.

Telephone Properties dialog - Credit Cards tab - Rename Credit Card dialog



Type the new name for the credit card.



Do not translate this topic. It is for help project administration only.

Telephone Properties dialog - Credit Cards tab - Dial Sequence Properties dialog



The Dial Sequence section determines the order in which the components that make up the call are dialed. For the listed services,
the defaults are appropriate in most cases.

Select the first action WinFax should perform after dialing the dial prefix, when sending a fax that will be billed to this credit card.



The Dial Sequence section determines the order in which the components that make up the call are dialed. For the listed services,
the defaults are appropriate in most cases.

Select the second action WinFax should perform when sending a fax that will be billed to this credit card.



The Dial Sequence section determines the order in which the components that make up the call are dialed. For the listed services,
the defaults are appropriate in most cases.

Select the third action WinFax should perform when sending a fax that will be billed to this credit card.



The Dial Sequence section determines the order in which the components that make up the call are dialed. For the listed services,
the defaults are appropriate in most cases.

Select the fourth action WinFax should perform when sending a fax that will be billed to this credit card.



The Dial Sequence section determines the order in which the components that make up the call are dialed. For the listed services,
the defaults are appropriate in most cases.

Select the fifth action WinFax should perform when sending a fax that will be billed to this credit card.



The Dial Sequence section determines the order in which the components that make up the call are dialed. For the listed services,
the defaults are appropriate in most cases.

Select the sixth action WinFax should perform when sending a fax that will be billed to this credit card.



The Dial Sequence section determines the order in which the components that make up the call are dialed. For the listed services,
the defaults are appropriate in most cases.

Select the last action WinFax should perform before dialing the dial suffix, when sending a fax that will be billed to this credit card.



Set the number of seconds you want WinFax to wait before performing the next step in the dialing sequence.



Do not translate this topic. It is for help project administration only.

Telephone Properties dialog - Modems tab



Lists all modems set up on your computer. Click the modem you want to modify or activate for use with TalkWorks.



Click this to set up a new modem.



Removes the selected modem in the modems list.



Click this to display the properties of the selected modem in the modems list.



Click this to test all ports on your computer for modems.



Makes the selected modem the active modem.



Displays the active modem.



Do not translate this topic. It is for help project administration only.

Properties For ... modem .... dialog



Specify the communications port used by your modem.



Adjust the volume of the modem during calls.



Enable this option if you want to hear the modem dialing until the connection is made.



Specify the modem type.



Select the type of telephone line you are using.



Type each string in the initialization sequence sent to your modem when you start and terminate WinFax. The entry depends on the
type of modem you are using.



Returns the entries in the Initialization String Sequence section to the default values for this modem.



Type the flow control string in this field. If you enabled Use Hardware Flow Control, type a hardware flow control string in this field.
Otherwise, type a software flow control string.



Enable this option to use hardware flow control. Type the hardware flow control string in the Flow Control field.



Type the reset string sent to your modem when you start and terminate WinFax. The entry depends on the type of modem you are
using.



Returns the entry in the Reset String field to the default value for this modem.



Set the maximum speed at which you want to send your fax. Some fax machines may be unable to receive pages at high speed
under certain circumstances.



Set the minimum speed at which WinFax sends the fax. When connecting to a remote fax station, your modem and the receiving
modem exchange information to determine how fast a fax can be transmitted. If the receiving fax machine is slow, the transmission
time and cost of the fax increases. WinFax will not transmit the fax if the remote fax station is incapable of receiving at your
minimum speed or higher.



Enable this option to use Error Correcting Mode (ECM) when sending faxes with this modem. This means that WinFax uses ECM
whenever possible for sending faxes.

ECM normally provides more reliable, error-free faxing. In some cases, you may have problems sending reliably to a particular fax
device with ECM enabled. Try disabling ECM and retry the fax.

By default, this option is enabled if you have a Class 1 modem.



Enable this option to use Error Correcting Mode (ECM) when receiving faxes with this modem. This means that WinFax uses ECM
whenever possible for receiving faxes. ECM normally provides more reliable error-free faxing.

If you disable this option, you cannot receive BFT events.

By default, this option is enabled if you have a Class 1 modem.



Enable this option to use high efficiency compression (2D) with this modem.

2D compression can greatly enhance transmission speed, however you may encounter problems sending with this option enabled,
particularly when sending grayscale images. You can disable this option to see if WinFax sends more reliably, but this also disables
MMR (Modified Modified Reed) compression, which will result in longer transmission times.



Tell me about TalkWorks

TalkWorks, the voice messaging option for WinFax, answers telephone calls on your telephone
modem line and directs callers to mailboxes you set up. Depending on the mailbox type, TalkWorks
may take a message, play an announcement and hang up, or fax information to the caller.

Mailbox Types

TalkWorks installs with a single mailbox with default settings. Use the Mailbox wizard to change the
settings for this mailbox or set up a multiple mailbox system.

Configure each mailbox you set up as one of the following:

. Voice message mailbox — A mailbox used to store callers’ messages.

. Announcement mailbox — A mailbox that plays an announcement and hangs up without taking
messages.

- Fax on demand mailbox — A mailbox that faxes information to callers. Callers can specify the

number to which they want the information faxed or they can receive it on the same line.
Greeting Types

TalkWorks includes Cover Your Voice—a collection of business and humorous greetings. If you
deleted this collection, you can run the TalkWorks Setup program any time to add the collection of
greetings.

Alternatively, you can record your own greetings when you set up mailboxes in the Mailbox wizard, or
you can import existing wave files. You can also use AudioEditor to record, edit and add effects to a
greeting and then import it when setting up a mailbox.

Depending on how you set up your mailbox system, you may need to select or record the following
types of greetings:

. System greeting — The greeting TalkWorks uses to answer the telephone.

. Mailbox menu — The message TalkWorks uses to ask the caller to enter the mailbox number.

. Mailbox greeting — The greeting callers hear when they access a mailbox.

. Announcement — The message callers hear when they access an Announcement mailbox.

. Document menu — The message TalkWorks uses to ask callers which document they want faxed

to them in a fax on demand mailbox.
Storing Messages

TalkWorks saves voice messages in wave (.\WAV) format and stores them in mailboxes. If you direct all
calls to a single mailbox (the default setting), TalkWorks stores the messages in the WinFax Receive
Log. If you create multiple mailboxes, TalkWorks prompts the caller to specify the appropriate mailbox
number and stores messages in the corresponding mailbox folder in the WinFax Logs window.

Retrieving Messages

Mailbox owners can play their messages from the TalkWorks Answering Machine, their mailbox folder
in the WinFax Logs window or from any touch tone telephone.



System requirements

The following table outlines the minimum and recommended system requirements necessary to install
and run TalkWorks.

In general, if you have installed Windows 95 and WinFax PRO 7.0 correctly, you have a compatible
voice modem and enough disk space, you can install and run TalkWorks.

Equipment Minimum Recommended

Computer Any PC running 486 or Pentium
Windows 95

Computer 8 MB 16 MB or more

Memory

Modem Voice-capable modem  Voice-capable modem
with a Rockwell or with a Rockwell or
Cirrus Logic chipset Cirrus Logic chipset

Graphics VGA SVGA

display

Hard disk 7 MB for the diskette 7 MB for the diskette

space installation or 10.5 MB installation or 10.5 MB
for the CD installation, for the CD installation,
additional free space additional free space
for voice wave files for voice wave files

Operating Windows 95 Windows 95

system

Additional Disk Space Requirements During Installation

You will require 2 MB of available uncompressed hard disk space in addition to the space required for
the installation. This additional space is required during the installation for temporary files, which are
removed when the installation is complete.

Other Operating Requirements

To hear and record voice messages, use one of the following:

- a voice modem with speaker phone capabilities

. a multi-function (sound/telephony/modem) card

. a sound card and microphone

. a telephone connected to the phone jack on your modem.

Sound quality depends on the hardware you are using. Adjust the voice answering setup to maximize
quality for your hardware.

To receive messages automatically with TalkWorks, you must have Automatic Receive and Voice
Answering enabled, and one of the following programs must be running:

. WinFax main window
. CommBar
. TalkWorks Answering Machine

. TalkWorks Telephone.



Planning your voice mailbox system

This topic provides a framework for planning your voice mailbox system. Use this information to design
your mailbox system before you start the TalkWorks Mailbox wizard.

Careful planning reduces setup time and can increase customer acceptance and usage of your voice
mailbox system.

Mailbox System Considerations

Create a flow chart that identifies what you want the callers to hear, when you want them to hear it and
the options you want to offer them. Modify the flow chart until you are satisfied with the structure. Use
the flow chart as a template to help determine how you want TalkWorks to answer calls and the
number of mailboxes you need.

Call Answering
Decide when you want TalkWorks to pick up the call and how you want to greet the caller.

TalkWorks answers the telephone after it rings a specified number of times and then plays a system
greeting. You can use a prerecorded TalkWorks greeting or record a custom system greeting of your
own.

Number Of Mailboxes

TalkWorks can direct all callers to a single mailbox or prompt the caller to specify the mailbox they
want to access.

Automatically directing the caller to a single mailbox eliminates the need for callers to press a mailbox
number before leaving a message. However, if you want your messages sorted by subject (that is,
customer complaints, accounts receivable and so on) or if you may need more mailboxes in the future,
you may want to create a multiple mailbox system. You can create a mailbox system that has only one
mailbox.

Mailbox Considerations

Create a list of mailboxes. For each mailbox, list the type, the messages required for this mailbox, the
mailbox name and number, and remote access password.

Mailbox Type
Configure each mailbox you set up as one of the following:

. Voice message mailbox — TalkWorks plays the specified greeting and then records any message.
Use one of the prerecorded mailbox greetings provided by TalkWorks or record a customized mailbox
greeting.

. Announcement mailbox — TalkWorks plays the specified greeting and then hangs up. Callers
cannot leave messages. Use one of the prerecorded announcements provided by TalkWorks or record a
customized announcement.

- Fax on demand mailbox. TalkWorks prompts callers to select a document to be faxed to them by
number. Record a customized document menu. The message should identify each document and the
document number. Create WinFax format fax image files (.FXS, .FXD or .FXR) for each document you
want to make available through the fax on demand mailbox.



Mailbox Identification
Identify each mailbox you create with a mailbox name and number.
The mailbox name appears whenever mailbox folders are listed either in the WinFax Logs window or

the Mailbox wizard. Use descriptive text for the mailbox name. For example, use the name of a person
or department as a mailbox name, or give a brief description of the function of the mailbox.

Specify the length of mailbox numbers. Make sure that available number range allows you to assign a
unique number for each mailbox. Remember that longer numbers are more difficult for callers to
remember and enter correctly.

Assign a unique mailbox number to each mailbox.

Callers are accustomed to dialing zero (0) for an operator. Set up a generic mailbox with mailbox
number zero and select or record an appropriate greeting.

Remote Access

Mailbox owners can change their mailbox greeting, retrieve remote messages or change their
password from any touch tone telephone.

To enable remote access for a mailbox, assign a remote access password. By default, TalkWorks does
not assign a remote access password to a new mailbox.

Recording Considerations

TalkWorks includes Cover Your Voice—a collection of business and humorous greetings. If you
deleted this collection, you can run the TalkWorks Setup program any time to add the collection of
greetings.

Alternatively, you can record your own greetings when you set up mailboxes in the Mailbox wizard, or
you can import existing wave files. You can also use AudioEditor to record, edit and add effects to a
greeting and then import it when setting up a mailbox.

Depending on how you set up your mailbox system, you may need to select or record the following
types of greetings:

System greeting — The greeting TalkWorks uses to answer the telephone.

Mailbox menu — The message TalkWorks uses to ask the caller to enter the mailbox number.
Mailbox greeting — The greeting callers hear when they access a specific mailbox.
Announcement — The message callers hear when they access an Announcement mailbox.
Document menu — The message TalkWorks uses to ask callers which document they want faxed
to them in a fax on demand mailbox.



Recording with TalkWorks

When calls to your office or home are answered by TalkWorks, callers listen to a series of greetings
and prompts. You determine what they hear when you make choices in the Mailbox wizard. Because
tone and quality of the prompts will affect the caller’s impression, it is important to create the best
possible prompts.

Achieving high quality recordings requires proper preparation. Recording quality is dependent on your
hardware, the speaker and the recording environment. Read this topic for tips on recording with
TalkWorks.

Recording Device
You can record messages in TalkWorks using any of the following recording devices:

your modem’s microphone

your computer’s sound card

your telephone handset.
Select the recording device in the TalkWorks Properties dialog. The recording devices available to you
depend on your hardware. Recording quality may vary with the device. If you have a sound card, it will
typically produce the best results.

Prepare a test message script and record it using each of the recording devices available on your
computer. Listen to each message to determine which recording device produces better results.
Repeat the test while adjusting the device settings until you determine the optimal recording setup for
your computer.

Recording Techniques
Recording messages takes practice. To improve the quality of the recording, do the following:

1. Listen to the prerecorded greetings supplied with TalkWorks. Even if you do not want to use them,
they will help stir your imagination when you create your own recordings.

2. Prepare a written script of each customized greeting, message or menu. Keep the message clear,
concise and brief.

3. Choose a speaker with a clear and pleasant voice to record your messages. For the highest
quality messages, consider hiring a professional voice model, recording in a studio and then
converting the messages into digital audio files you can import into TalkWorks.

4. Practice reading the script. Focus on pronouncing words clearly and adding expression (pauses,
changes in tone and so on) to the delivery. Take your time and breath normally; your breathing
may be audible on the recorded message.

Position the speaker so they can speak directly into the recording device.
Position the recording device approximately six to eight inches away from you.

Record in a quiet room. Any background noise that is present while you are recording will become
part of the recording. If your computer has a noisy fan, make your recordings as far away from the
fan as possible.

8. Place your script so that you can easily read it while speaking into the recording device without
moving the paper.

9. Do not touch the recording device or breathe directly into it while you are recording.

10. Edit the message in AudioEditor to remove extended silences at the beginning and end of
recordings and add any required effects.



11. Callin and listen to the message as your caller will.



A typical voice mailbox system

The script below represents a sample TalkWorks voice mailbox system. Your mailbox system may
contain some or all of these components.

(System Greeting)

Welcome to Weldon & Garcia Associates

(Mailbox menu)

Please enter the mailbox number ...

0 1 2 3

(Voice) (Voice) (Announcement) (Fax On Demand)

The scenarios below represent what happens when you select each of the mailboxes. The greetings
used below are custom greetings.

If the caller presses press “0” ...

Thank you for calling Weldon & Garcia. No one is available to take
your call. Please leave your name, telephone number and message
and we will return your call. (Mailbox Greeting)

<beep>

This is Natasha Irvine calling for Gregory Rankin. I’m calling to
discuss the agenda for the meeting tomorrow. Please call me at 555-
1287 as soon as possible.

If the caller presses “1” ...

Hi, this is Hilary Kellough at Weldon & Garcia Associates on
Wednesday, November 1st. | can’t take your call right now. Please
leave your name, number and message after the beep.

(Mailbox Greeting)

<beep>
Sharon, this is Tyrone Stewart at MacDonald Motors. Your car is

ready for pickup. If you need someone to pick you up, please call me
at 555-8721 before 4:00 p.m. today.

If the caller presses “2” ...

Weldon & Garcia Associates is located at 274 Main Street, Boston,
Massachusetts. The zip code is 263817. You may fax us at (617) 555-
1274.

(Announcement Greeting)



<pause>

Weldon & Garcia Associates is located at 274 Main Street, Boston,
Massachusetts. The zip code is 263817. You may fax us at (617) 555-
1274.

If the caller presses “3” ...

Thank you for calling our fax info line.

For our catalog, press 1.

For our price list, press 2.

For a list of stores that carry our product line, press 3.
(Document menu)

<The caller presses the appropriate number.>

<TalkWorks prepares to send the fax.>




Typical call answering scenarios

The way TalkWorks answers an incoming telephone call depends on how you set up your mailbox
system. The following sections describe typical call scenarios for different ways you can set up your
mailbox system. TalkWorks provides prerecorded greetings, messages and menus you can use. You
can also record your own custom messages. In some scenarios, standard greetings, messages and
prompts provided by TalkWorks are used; in others, custom recordings are used.

Single Voice Message Mailbox
1. TalkWorks answers the telephone with the mailbox greeting.

You have reached the voice mailbox of Gregory Rankin. | am either away from my desk or on the
telephone. Please leave your name, number and message after the beep. I will return your call as soon
as possible.

2. Atthe end of the greeting, the caller hears a beep indicating the start of message recording.
Beep
3. The caller says their message.

Gregory, this is Natasha Irvine calling. | am calling to discuss the agenda for the meeting tomorrow.
Please call me at 555-1287 as soon as possible.

4. If the caller presses the number sign (#) or waits for TalkWorks to detect the end of their message,
they hear the following menu:

Recording stopped.

To review your message, press 1.
To re-record your message, press 2.
To quit, press the number sign.

5. The caller reviews and re-records the message, as required.

6. After the caller presses the number sign (#) or hangs up, TalkWorks places the voice message in
the Receive Log folder.

Single Announcement Mailbox

1. TalkWorks answers the telephone with the system greeting.
This call is being answered by TalkWorks.

2. TalkWorks plays the announcement twice and hangs up.

Weldon & Garcia Associates is located at 274 Main Street, Boston, Massachusetts. The zip code is
182736. You may fax us at (617) 555-1274.

Weldon & Garcia Associates is located at 274 Main Street, Boston, Massachusetts. The zip code is
182736. You may fax us at (617) 555-1274.



The caller cannot leave a message.

Mailbox System (Voice Message Mailbox Example)

1.

TalkWorks answers the telephone with the system greeting.

This call is being answered by TalkWorks.

. At the end of the greeting, TalkWorks plays the mailbox menu asking the caller to press the mailbox

number of the person they want to leave a message for.

Please enter the mailbox number.

3. The caller presses the mailbox number.

4. TalkWorks plays the corresponding mailbox greeting.

You have reached the voice mailbox of Gregory Rankin. | am either away from my desk or on the
telephone. Please leave your name, number and message after the beep. I will return your call as soon
as possible.

At the end of the greeting, the caller hears a beep indicating the start of message recording.
Beep
The caller says their message.

Gregory, this is Natasha Irvine calling. | am calling to discuss the agenda for the meeting tomorrow.
Please call me at 555-1287 as soon as possible.

If the caller presses the number sign (#) or waits for TalkWorks to detect the end of their message,
they hear the following menu:

Recording stopped.

To review your message, press 1.

To re-record your message, press 2.
To quit, press the number sign.

8. The caller reviews and re-records the message, as required.

9. After the caller presses the number sign (#) or hangs up, TalkWorks places the voice message in

the corresponding mailbox folder in the Logs window.

Mailbox System (Announcement Mailbox Example)

1.

TalkWorks answers the telephone with the system greeting.
Thank you for calling Weldon & Garcia Associates.

At the end of the greeting, TalkWorks plays the mailbox menu asking the caller to specify what the
want to do.



To leave a message for Gregory Rankin, press 1.

To leave a message for Paul Carlton, press 2.

To leave a message for the customer service department, press 3.
For our current mailing address and fax number, press 4.

3. The caller presses number “4” on their telephone number pad.

4. TalkWorks plays the announcement twice and hangs up.

Weldon & Garcia Associates is located at 274 Main Street, Boston, Massachusetts. The zip code is
182736. You may fax us at (617) 555-1274.

Weldon & Garcia Associates is located at 274 Main Street, Boston, Massachusetts. The zip code is
182736. You may fax us at (617) 555-1274.

The caller cannot leave a message.

Mailbox System (Fax On Demand Mailbox Example)

1.

TalkWorks answers the telephone with the system greeting.

Thank you for calling Weldon & Garcia Associates.

. At the end of the greeting, TalkWorks plays the mailbox menu asking the caller to specify what the

want to do.

To leave a message for Gregory Rankin, press 1.

To leave a message for Paul Carlton, press 2.

To leave a message for the customer service department, press 3.
For our current mailing address and fax number, press 4.

To have product information faxed to you, press 5.

3. The caller presses number “5” on their telephone number pad.

4. TalkWorks plays the mailbox greeting.

Thank you for calling our fax information line. In order to receive faxed documents, you must be
calling from your fax machine.

TalkWorks plays the document menu asking the caller to press the number corresponding to the
document they want faxed to them.

For our catalog, press 1.
For our price list, press 2.
For a list of stores that carry our product line, press 3.

6. The caller presses the appropriate document number.

7. TalkWorks asks the caller to press the Send button on their fax machine or specify the fax number

to which to send the information.

TalkWorks begins sending the fax.



Tell me about the TalkWorks Telephone

Use the TalkWorks Telephone to make phone calls from your modem. You can dial out manually, use
speed dial or retrieve the number from your WinFax phonebooks. If you have speaker phone
capabilities, you can also use the Telephone to answer incoming calls.

You can dial directly from the Telephone by clicking the number keys with your mouse, by clicking Dial
and using the Dial Telephone dialog or by keying the number and clicking Dial. If you use the numeric
keypad on your keyboard, remember that it is not the same as a telephone keypad.



Tell me about the TalkWorks Answering Machine

Use the TalkWorks Answering Machine to play back your voice messages, and to record memos and
greetings.



SETUP



WinFax main window

Enabling voice answering

1. On the Setup menu, click TalkWorks. The TalkWorks Properties dialog appears.
2. Click the Answer tab.

3. Enable Voice Answering.

Notes

To receive voice messages with TalkWorks, you must also enable Automatic Receive on the Receive menu.
To hear and record voice messages, use a voice modem with speaker phone capabilities, a multi-function
(sound/telephony/modem) card, a sound card and microphone or a telephone connected to the phone jack on your
modem. Sound quality depends on the hardware you are using.



WinFax main window

Specifying the minimum message length

1. On the Setup menu, click TalkWorks. The TalkWorks Properties dialog appears.
2. Click the Answer tab.

3. Inthe Do Not Accept Messages Shorter Than field, type the minimum message length, in seconds.

Notes

" The default is two seconds.

. Use this feature to prevent TalkWorks from recording messages when the caller has hung up without saying
anything.

[0 Related Topics



WinFax main window

Specifying the maximum message length

1. On the Setup menu, click TalkWorks. The TalkWorks Properties dialog appears.
2. Click the Answer tab.

3. Inthe Stop Recording Messages After field, type the maximum message length, in seconds.

Note

" The default is 180 seconds.

[ Related Topics



WinFax main window

Specifying the telephone call announcement sound

1. On the Setup menu, click TalkWorks. The TalkWorks Properties dialog appears.
2. Click the Answer tab.

3. In the Options section, do either of the following:

Type the path and file name of the wave file you want TalkWorks to play to announce an incoming telephone
call.

. Click Browse, select the appropriate wave file and click Open. The Answer tab reappears.

Notes

TalkWorks plays the wave file each time your telephone rings. For example, if you set up TalkWorks to
answer the telephone after four rings, you hear this wave file four times for each incoming call.

- If you do not want to be notified each time TalkWorks detects an incoming call, leave this field blank.

- You can also change this setting in the Telephone Properties dialog.

. If you are using the Receive Log as your mailbox, WinFax can notify you of new messages. On the Setup
menu, click Receive and enable Notify on the After Receive tab of the Receive Properties dialog.



WinFax main window

Automatically detecting the end of a message

1. On the Setup menu, click TalkWorks. The TalkWorks Properties dialog appears.
2. Click the Answer tab.

3. Adjust the Silence Detection Sensitivity slide control as required.

Notes

This saves mailbox disk space by eliminating long silences at the end of voice messages.

Set the slide control to Off if you want TalkWorks to continue recording even when it detects a period of
silence. If you set the slide control to any other position, TalkWorks will automatically stop recording when it detects a
period of silence during recording. The slide control position determines how sensitive TalkWorks is to noises when

trying to detect periods of silence. If your telephone line has a lot of background noise, adjust this setting towards the
High end of the slide control.



WinFax main window

Setting the level of compression

1. On the Setup menu, click TalkWorks. The TalkWorks Properties dialog appears.
2. Click the Answer tab.

3. Inthe Compression drop-down list, do either of the following:

If you want high quality messages, regardless of the amount of disk space they use, click Best Voice Quality.
If you want to minimize the disk space used by voice messages, click Conserve Disk Space.

[ Related Topics



WinFax main window

Using the 24-hour clock to announce the message time

1. On the Setup menu, click TalkWorks. The TalkWorks Properties dialog appears.
2. Click the Answer tab.

3. In the Options section, enable Announce Message Time Using 24-Hour Clock.

Notes

If you disable this option, TalkWorks announces the time messages were left using the 12-hour clock with
the appropriate a.m. or p.m. label.

. TalkWorks plays the message time when you retrieve your messages remotely. In the Receive Log, check

the message time in the Time column. In the Answering Machine, the message time appears in the call display
screen during playback.



WinFax main window

Specifying the playback device

1. On the Setup menu, click TalkWorks. The TalkWorks Properties dialog appears.
2. Click the Device tab.

3. In the Playback drop-down list, click the hardware device you want to use to play back voice messages.

To use your modem’s speaker, click (Modem) Speaker.

. To use your computer’s sound card, click (Wave) Wave Mapper.

- To have TalkWorks prompt you to pick up your handset to hear voice messages played back to you, click
(Modem) Telephone Set.

- To have TalkWorks call a specified phone number to play back your voice messages, click (Modem) Dial
Phone Number and type the phone number in the Phone Number field.

Note

The contents of the Playback drop-down vary depending on your hardware. If you have a sound card, the
default is (Wave) Wave Mapper. If not, the default is (Modem) Telephone Set.



WinFax main window

Specifying the recording device

1. On the Setup menu, click TalkWorks. The TalkWorks Properties dialog appears.
2. Click the Device tab.

3. Inthe Recording drop-down list, click the hardware device you want to use to record voice messages.

. To use your modem’s microphone, click (Modem) MIC.
. To use your computer’s sound card, click (Wave) Wave Mapper.

- To have TalkWorks prompt you to pick up your handset to record voice messages, click (Modem) Telephone
Set.

To have TalkWorks call a specified phone number to record your voice messages, click (Modem) Dial Phone
Number and type the phone number in the Phone Number field.

Note

The contents of the Recording drop-down list vary depending on your hardware. If you have a sound card,
the default is (Wave) Wave Mapper. If not, the default is (Modem) Telephone Set.



WinFax main window

Specifying the playback volume

1. On the Setup menu, click TalkWorks. The TalkWorks Properties dialog appears.
2. Click the Device tab.

3. Drag the Volume slide control that appears directly below the Playback drop-down list to the appropriate level.



WinFax main window

Specifying the recording volume

1. On the Setup menu, click TalkWorks. The TalkWorks Properties dialog appears.
2. Click the Device tab.

3.
4

In the Recording drop-down list, click (Modem) Dial Phone Number, (Modem) Telephone Set or (Modem) MIC.

. Drag the Volume slide control that appears directly below the Recording drop-down list to the appropriate

level.



WinFax main window

Setting the voice compression method

1. On the Setup menu, click TalkWorks. The TalkWorks Properties dialog appears.
2. Click the Device tab.

3. Click Advanced. The Tune Performance dialog appears.

4. In the Recording section, click the option that best describes your computer.

. If you are using a 486 or Pentium processor, click Fast Computer. TalkWorks compresses your voice files
while you record them and play them back.
. If you are using a 486 or Pentium processor with a fast disk, click Fast Computer, Fast Disk. TalkWorks
compresses your voice files in a buffer while you record them.
. If you are using a 386 processor, click Slower Computer. TalkWorks compresses your voice files after you
finish recording them and playing them back.

5. In the Playback section, click the option that best describes your computer.

Notes

. The speed of your computer determines whether TalkWorks compresses voice wave files during or after
recording and playback. TalkWorks detects your processor speed during installation, and sets wave compression
accordingly.

. You can only specify the compression method if you are using one of the (Wave) playback or recording
devices.

[0 Related Topics



MAILBOX WIZARD



WinFax main window

Starting the Mailbox wizard from WinFax
On the TalkWorks menu, click Mailbox Wizard.



WinFax main window

Starting the Mailbox wizard from the Answering Machine

1. On the TalkWorks menu, click Answering Machine.
2. On the Telephone, click Menu. A drop-down menu appears.
3. Click Mailbox Wizard.



WinFax main window

Setting up a single voice message mailbox

Use this procedure if you want TalkWorks to direct all callers to a single voice message mailbox without prompting
them for a mailbox number. All messages left in this mailbox appear in the WinFax Receive Log.

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.
3. Specify how you want TalkWorks to answer calls.

(i) In the Answer After field, click the number of times you want the telephone to ring before TalkWorks
answers.

(i) Click Direct All Calls To A Single Mailbox.
(iiif) Click Next. The Accept Voice Messages panel appears.

4. In the After The Greeting Is Played section, click Allow Caller To Record A Voice Message and click Next. The
Greeting Type panel appears.

5. Specify the mailbox greeting you want TalkWorks to use.

- If you want to use one of the provided greetings, click Play A TalkWorks Greeting and click Next. The Select
A TalkWorks Greeting panel appears. In the Name list, click the greeting you want to use. The script of the greeting
appears in the Description section. To hear the greeting, click the Play button.
. If you want to record your own greeting, click Play A Custom Greeting | Record and click Next. The Record
Greeting panel appears. Click the Record button and say your message after the beep. Click the Stop button when
you are finished.
. If you want to use an existing wave file (.WAV) as your greeting, click Play A Custom Greeting | Record and
click Next. The Record Greeting panel appears. Click Import, select the wave file you want to use in the Import
Greeting File dialog and click Open. The Record Greeting panel reappears.

Click Next. The Remote Access panel appears.

6. Inthe Password field, type the password you want to use to access this mailbox from a touch tone telephone
and click Next. The Selection Summary panel appears.

7. A summary of all mailbox options you selected appears. Do either of the following:

. To change any of your selections, click Back repeatedly until you reach the appropriate panel, make the
changes and click Next repeatedly until you return to this panel.
- If you do not need to make changes, click Finish.

[0 Related Topics



WinFax main window

Setting up a single announcement mailbox

Use this procedure if you want TalkWorks to direct all callers to a single announcement mailbox, play an
announcement twice and then hang up. Callers will not be able to leave a message.

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.
3. Specify how you want TalkWorks to answer calls.

(i) In the Answer After field, click the number of times you want the telephone to ring before TalkWorks
answers.

(i) Click Direct All Calls To A Single Mailbox.
(iiif) Click Next. The Accept Voice Messages panel appears.
4. In the After The Greeting Is Played section, click Hang Up and click Next. The Greeting Type panel appears.

5. Specify the announcement you want TalkWorks to play when it answers the telephone.

- If you want to use one of the TalkWorks announcements, click Play A TalkWorks Greeting and click Next.
The Select A TalkWorks Greeting panel appears. In the Name list, select the announcement you want to use. The
script of the announcement appears in the Description section. To hear the announcement, click the Play button.
. If you want to record your announcement, click Play A Custom Greeting | Record and click Next. The Record
Greeting panel appears. Click the Record button and say your announcement after the beep. Click the Stop button
when you are finished.
. If you want to use an existing wave file (.WAV) as your announcement, click Play A Custom Greeting |
Record and click Next. The Record Greeting panel appears. Click Import, select the wave file you want to use in the
Import Greeting File dialog and click Open. The Record Greeting panel reappears.

Click Next. The Remote Access panel appears.

6. Inthe Password field, type the password you want to use to access this mailbox from a touch tone telephone
and click Next. The Selection Summary panel appears.

7. A summary of all mailbox options you selected appears. Do either of the following:

. To change any of your selections, click Back repeatedly until you reach the appropriate panel, make the
changes and click Next repeatedly until you return to this panel.
- If you do not need to make changes, click Finish.

[0 Related Topics
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Creating a voice message mailbox (Mailbox system)

Use this procedure if you want TalkWorks to answer the telephone with a system greeting, ask the caller to specify
the mailbox they want to access and then record the callers” message in the specified mailbox. All messages left
in this mailbox appear in the corresponding mailbox folder in the WinFax Logs window.

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.

2. Click Next when you are ready to proceed. The Call Answering panel appears.

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

w

Specify your system greeting and click Next after each panel until you reach the Edit Mailbox List panel.
Click Add. The Mailbox Name panel appears.
In the Name field, type the name of the new mailbox and click Next. The New Mailbox Type panel appears.

Click Voice And Fax Messages and click Next. The Mailbox Greeting Type panel appears.
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Specify the mailbox greeting you want to play for this mailbox.

. If you want to use one of the provided greetings, click Play A TalkWorks Greeting and click Next. The Select
A TalkWorks Mailbox Greeting panel appears. In the Name list, select the greeting you want to use. The script of the
greeting appears in the Description section. To hear the greeting, click the Play button.
- If you want to record your own greeting, click Play A Custom Greeting | Record and click Next. The Record
Mailbox Greeting panel appears. Click the Record button and say your message after the beep. Click the Stop button
when you are finished.
- If you want to use an existing wave file (.WAV) as your greeting, click Play A Custom Greeting | Record and
click Next. The Record Mailbox Greeting panel appears. Click Import, select the wave file you want to use in the
Import Greeting File dialog and click Open. The Record Mailbox Greeting panel reappears.

Click Next. The Remote Access panel appears.

9. In the Password field, type the password you want to use to access this mailbox from a touch tone telephone
and click Next. The New Mailbox Summary panel appears.

10. A summary of all mailbox options you selected for this mailbox appears. Do either of the following:

- To change any of your selections, click Back repeatedly until you reach the appropriate panel, make the
changes and click Next repeatedly until you return to this panel.
. If you do not need to make changes, click Create. The Edit Mailbox List panel appears.

Click Next. The Assign Mailbox Numbers panel appears.

11. Assign mailbox numbers and specify how you want TalkWorks to ask the caller for the mailbox number. Follow
the instructions on screen and click Next after each panel until you reach the Selection Summary panel.

12. Click Finish.

Note

. After clicking Create to create the new mailbox, you must advance through the wizard panels and click
Finish in the Selection Summary panel to save your settings. Otherwise, the mailbox is not created.

[0 Related Topics
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Creating a multiple mailbox system

Use this procedure if you want to set up a mailbox system of one or more mailboxes (voice message,
announcement or fax on demand). In a voice mailbox system, TalkWorks answers the telephone with a system
greeting and asks the caller to specify the mailbox they want to access. TalkWorks then records a message, plays
an announcement or faxes selected documents, based on the mailbox selection.

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.
3. Specify how you want TalkWorks to answer calls.

(i) In the Answer After field, click the number of times you want the telephone to ring before Talk\Works
answers.

(ii) Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create.
(iii) Click Next. The System Greeting Type panel appears.
4. Specify the system greeting you want TalkWorks to use to answer the telephone.

- If you want to use one of the provided greetings, click Play A TalkWorks Greeting and click Next. The Select
A TalkWorks System Greeting panel appears. In the Name list, select the greeting you want to use. The script of the
greetlng appears in the Description section. To hear the greeting, click the Play button.

If you want to record your own greeting, click Play A Custom Greeting That | Record and click Next. The
Record System Greeting panel appears. Click the Record button and say your message after the beep. Click the
Stop button when you are finished.
. If you want to use an existing wave file ((WAV) as your greeting, click Play A Custom Greeting That | Record
and click Next. The Record System Greeting panel appears. Click Import, select the wave file you want to use in the
Import Greeting File dialog and click Open. The Record System Greeting panel reappears.

Click Next. The Edit Mailbox List panel appears.

5. Click Add. Do one of the following.

. Create a voice message mailbox. For more information, click here
* and follow the instructions starting with step #5.
" Create an announcement mailbox. For more information, click here
* and follow the instructions starting with step #5.
" Create a fax on demand mailbox. For more information, click here
* and follow the instructions starting with step #5.

6. Repeat step #5 for each mailbox you want to create.

7. Click Next. The Assign Mailbox Numbers panel appears.
8. Specify the length of mailbox numbers and assign a number to each mailbox.

(i) If you want to change the number of digits in the mailbox number, click the number in the Number Of Digits
In Mailbox Number field.

(i) In the mailbox list, click a mailbox.
(iii) Click Assign. The Assign Mailbox Number dialog appears.

(iv) Click Allow Access When The Caller Enters, click the mailbox number in the drop-down list and click OK.
The Assign Mailbox Numbers panel reappears.

(v) Repeat this step for each mailbox in the list.
(vi) Click Next. The Mailbox Menu panel appears.
9. Specify how you want TalkWorks to ask the caller for the mailbox number.

" If you want to use the standard TalkWorks mailbox menu, click Play The TalkWorks Message.

. If you want to record your own mailbox menu, click Play A Custom Menu That | Record. The Record Mailbox
Menu panel appears. Click the Record button, record your message after the beep and click the Stop button after you
are finished.

. If you want to use an existing wave file (WAV) as your mailbox menu, click Play A Custom Menu That |
Record and click Next. The Record Mailbox Menu panel appears. Click Import, select the wave file you want to use in
the Import Greeting File dialog and click Open. The Record Mailbox Menu panel reappears.



Click Next. The Selection Summary panel appears.

10. A summary of all mailbox options you selected appears. Do either of the following:

. To change any of your selections, click Back repeatedly until you reach the appropriate panel, make the
changes and click Next repeatedly until you return to this panel.
- If you do not need to make changes, click Finish.
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Creating an announcement mailbox (Mailbox system)

Use this procedure if you want TalkWorks to answer the telephone with a system greeting, ask the caller to specify
the mailbox they want to access and then play an announcement in that mailbox. Callers cannot leave a
message.

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.

2. Click Next when you are ready to proceed. The Call Answering panel appears.

3. Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

4. Specify your system greeting and click Next after each panel until you reach the Edit Mailbox List panel.

5. Click Add. The Mailbox Name panel appears.

6. In the Name field, type the name of the new mailbox and click Next. The New Mailbox Type panel appears.

7. Click Announcements Only and click Next. The Mailbox Greeting Type panel appears.

8. Specify the announcement you want to play for this mailbox.

- If you want to use one of the provided announcements, click Play A TalkWorks Greeting and click Next. The
Select A TalkWorks Mailbox Greeting panel appears. In the Name list, select the announcement you want to use. The
script of the announcement appears in the Description section. To hear the announcement, click the Play button.
. If you want to record your own announcement, click Play A Custom Greeting | Record and click Next. The
Record Mailbox Greeting panel appears. Click the Record button and say your message after the beep. Click the
Stop button when you are finished.
. If you want to use an existing wave file ((WAV) as your announcement, click Play A Custom Greeting |
Record and click Next. The Record Mailbox Greeting panel appears. Click Import, select the wave file you want to
use in the Import Greeting File dialog and click Open. The Record Mailbox Greeting panel reappears.

Click Next. The Remote Access panel appears.

9. In the Password field, type the password you want to use to access this mailbox from a touch tone telephone
and click Next. The New Mailbox Summary panel appears.

10. A summary of all mailbox options you selected for this mailbox appears. Do either of the following:

. To change any of your selections, click Back repeatedly until you reach the appropriate panel, make the
changes and click Next repeatedly until you return to this panel.
. If you do not need to make changes, click Create. The Edit Mailbox List panel appears.

Click Next. The Assign Mailbox Numbers panel appears.

11. Assign mailbox numbers and specify how you want TalkWorks to ask the caller for the mailbox number. Follow
the instructions on screen and click Next after each panel until you reach the Selection Summary panel.

12. Click Finish.

Notes

. After clicking Create to create the new mailbox, you must advance through the wizard panels and click
Finish in the Selection Summary panel to save your settings. Otherwise, the mailbox is not created.
. Announcement mailboxes cannot store caller messages.
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Creating a fax on demand mailbox (Mailbox system)

Use this procedure if you want TalkWorks to answer the telephone with a system greeting, ask the caller to specify
the mailbox they want to access and then fax documents to the caller from the mailbox. Before you begin, create
fax-ready format image files of your documents in WinFax.

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.

2. Click Next when you are ready to proceed. The Call Answering panel appears.

3. Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

4. Specify your system greeting and click Next after each panel until you reach the Edit Mailbox List panel.

5. Click Add. The Mailbox Name panel appears.

6. In the Name field, type the name of the new mailbox and click Next. The New Mailbox Type panel appears.

7. Click Fax On Demand and click Next. The Record Greeting panel appears.

8. Specify the greeting you want to play for this mailbox.
- If you want to record your own greeting, click the Record button and say your message after the beep. Click
the Stop button when you are finished.
. If you want to use an existing wave file (.WAV) as your greeting, click Import, select the wave file you want to

use in the Import Greeting File dialog and click Open. The Record Greeting panel reappears.
Click Next. The Fax On Demand Documents panel appears.

9. Click Add. The Fax On Demand Properties dialog appears.

10. Create a document from your WinFax fax-ready image file.

- In the Name field, type a name for the new fax on demand document.

- In the Description field, type text to help you identify this fax on demand document in the future.

- Click Add. The Select Files To Add To This Document dialog appears. Select the fax image files (.FXS, .FXR
or .FXD) that make up this document.

. Click OK. The Fax On Demand Documents panel reappears with the new document listed.

11. Repeat steps #9 and #10 for each document you want to appear in your fax on demand system.
12. Click Next. The Assign Document Numbers panel appears.
13. Specify the length of document numbers and assign a number to the document.

(i) If you want to change the number of digits in the document number, click the number in the Number Of
Digits In Document Number field.

(ii) In the document list, select the document you just created.
(iii) Click Assign. The Assign Document Number dialog appears.

(iv) Click Allow Access When The Caller Enters, click the document number in the drop-down list and click
OK. The Assign Document Numbers panel reappears.

(v) Repeat for each document in your fax on demand mailbox.
(vi) Click Next. The Record Document Menu panel appears.
14. Specify a spoken menu for TalkWorks to play asking the caller to select the document they want.

. If you want to record a menu, click the Record button and say your menu after the beep. Click the Stop
button when you are finished.
. If you want to use an existing wave file ((WAV), click Import, select the file in the Import Greeting File dialog

and click Open. The Record Document Menu panel reappears.
Click Next. The New Mailbox Summary panel appears.

15. A summary of all mailbox options you selected for this mailbox appears. Do either of the following:

- To change any of your selections, click Back repeatedly until you reach the appropriate panel, make the
changes and click Next repeatedly until you return to this panel.
. If you do not need to make changes, click Create. The Edit Mailbox List panel appears.



Click Next. The Assign Mailbox Numbers panel appears.

16. Assign mailbox numbers and specify how you want TalkWorks to ask the caller for the mailbox number. Follow
the instructions on screen and click Next after each panel until you reach the Selection Summary panel.

17. Click Finish.

Note

- After clicking Create to create the new mailbox, you must advance through the wizard panels and click
Finish in the Selection Summary panel to save your settings. Otherwise, the mailbox is not created.
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Modifying settings for a single voice mailbox

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.
3. Specify how you want TalkWorks to answer calls.

(i) Inthe Answer After field, click the number of times you want the telephone to ring before TalkWorks
answers.

(i) Click Direct All Calls To A Single Mailbox.
(iii) Click Next. The Accept Voice Messages panel appears.

4. In the After The Greeting Is Played section, click Allow Caller To Record A Voice Message and click Next. The
Greeting Type panel appears.

5. Specify the mailbox greeting you want TalkWorks to use.

. If you want to use one of the provided greetings, click Play A TalkWorks Greeting and click Next. The Select
A TalkWorks Greeting panel appears. In the Name list, click the greeting you want to use. The script of the greeting
appears in the Description section. To hear the greeting, click the Play button.
. If you want to record your own greeting, click Play A Custom Greeting | Record and click Next. The Record
Greeting panel appears. Click the Record button and say your message after the beep. Click the Stop button when
you are finished.
. If you want to use an existing wave file (.WAV) as your greeting, click Play A Custom Greeting | Record and
click Next. The Record Greeting panel appears. Click Import, select the wave file you want to use in the Import
Greeting File dialog and click Open. The Record Greeting panel reappears.

Click Next. The Remote Access panel appears.

6. Inthe Password field, type the password you want to use to access this mailbox from a touch tone telephone
and click Next. The Selection Summary panel appears.

7. A summary of all mailbox options you selected appears. Do either of the following:

. To change any of your selections, click Back repeatedly until you reach the appropriate panel, make the
changes and click Next repeatedly until you return to this panel.
" If you do not need to make changes, click Finish.
Note
- Changing the settings requires you to rerun the TalkWorks Mailbox wizard to reset any or all of the current

settings.
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Modifying settings for a single announcement mailbox

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.
3. Specify how you want TalkWorks to answer calls.

(i) Inthe Answer After field, click the number of times you want the telephone to ring before TalkWorks
answers.

(i) Click Direct All Calls To A Single Mailbox.
(iii) Click Next. The Accept Voice Messages panel appears.
In the After The Greeting Is Played section, click Hang Up and click Next. The Greeting Type panel appears.

5. Specify the announcement you want TalkWorks to play when it answers the telephone.

- If you want to use one of the TalkWorks announcements, click Play A TalkWorks Greeting and click Next.
The Select A TalkWorks Greeting panel appears. In the Name list, select the announcement you want to use. The
script of the announcement appears in the Description section. To hear the announcement, click the Play button.
- If you want to record your announcement, click Play A Custom Greeting | Record and click Next. The Record
Greeting panel appears. Click the Record button and say your announcement after the beep. Click the Stop button
when you are finished.
. If you want to use an existing wave file ((WAV) as your announcement, click Play A Custom Greeting |
Record and click Next. The Record Greeting panel appears. Click Import, select the wave file you want to use in the
Import Greeting File dialog and click Open. The Record Greeting panel reappears.

Click Next. The Remote Access panel appears.

6. Inthe Password field, type the password you want to use to access this mailbox from a touch tone telephone
and click Next. The Selection Summary panel appears.

7. A summary of all mailbox options you selected appears. Do either of the following:

- To change any of your selections, click Back repeatedly until you reach the appropriate panel, make the
changes and click Next repeatedly until you return to this panel.
. If you do not need to make changes, click Finish.
Note
- Changing the settings requires you to rerun the TalkWorks Mailbox wizard to reset any or all of the current

settings.
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Modifying mailbox settings (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.
3. Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next.
4. Click Next repeatedly until you reach the Edit Mailbox List panel.
5. In the mailbox list, click the mailbox you want to modify.
6. Click Properties. A tabbed dialog appears.
7. Select the appropriate tab, make the required changes and click OK. The Edit Mailbox List panel reappears.
8. Click Next repeatedly until the Selection Summary panel appears.
9. Click Finish.
Notes
- After making changes to your mailbox settings, you must advance through the wizard panels and click Finish

in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.
- The tabs available vary depending on the mailbox type (voice message, announcement or fax on demand).
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Using a TalkWorks system greeting (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.

3. Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

4. Click Play A TalkWorks Greeting and click Next. The Select A TalkWorks System Greeting panel appears.

5. Inthe Name list, select the greeting you want to use. The script of the greeting appears in the Description
section. If you want to hear the greeting, click the Play button.

6. Click Next repeatedly until you reach the Selection Summary panel.
7. Click Finish.
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Recording a new system greeting (Mailbox system)

1.
2.
3.

On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
Click Next when you are ready to proceed. The Call Answering panel appears.

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

4. Click Play A Customized Greeting That | Record and click Next. The Record System Greeting panel appears.
5. Click the Record button.

6. After the beep, say your system greeting.

7.
8
9
1

When you are finished recording, click the Stop button.

. Click the Play button. TalkWorks plays your recording back.
. Click Next repeatedly until you reach the Selection Summary panel.
0. Click Finish.

Note

If you want to re-record the system greeting, click the Record button again.
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Using an existing wave file as a system greeting (Mailbox system)

1.
2.

w
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On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
Click Next when you are ready to proceed. The Call Answering panel appears.

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

Click Play A Custom Greeting That | Record and click Next. The Record System Greeting panel appears.
Click Import. The Import Greeting File dialog appears.

Select the wave file (.WAV) you want to use and click Open. The Record System Greeting panel reappears.
Click Next repeatedly until you reach the Selection Summary panel.

Click Finish.
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Using the standard mailbox menu (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.

3. Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

4. Click Next repeatedly until you reach the Mailbox Menu panel.
5. Click Play The TalkWorks Message and click Next. The Selection Summary panel appears.
6. Click Finish.
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Recording your own mailbox menu (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.

3. Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

. Click Next repeatedly until you reach the Mailbox Menu panel.
. Click Play A Custom Menu That | Record and click Next. The Record Mailbox Menu panel appears.
. Click the Record button.

4

5

6

7. After the beep, say the new mailbox menu.

8. When you are finished recording, click the Stop button.
9. Click Next. The Selection Summary panel appears.

1

0. Click Finish.

Notes

To listen to the new mailbox menu, click the Play button.
To re-record the mailbox menu, click the Record button.
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Using an existing wave file as a mailbox menu (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

w

Click Next repeatedly until you reach the Mailbox Menu panel.

Click Play A Custom Menu That | Record and click Next. The Record Mailbox Menu panel appears.
Click Import. The Import Greeting File dialog appears.

Select the wave file you want to use and click Open. The Record Mailbox Menu panel reappears.
Click Next. The Selection Summary panel appears.

Click Finish.
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Changing the number of rings before TalkWorks answers (Mailbox system)

On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.

Click Next when you are ready to proceed. The Call Answering panel appears.

In the Answer After field, click the number of times you want the telephone to ring before TalkWorks answers.
Click Next repeatedly until the Selection Summary dialog appears.

Click Finish.
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Changing the mailbox name (Mailbox system)

1.

On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.

2. Click Next when you are ready to proceed. The Call Answering panel appears.

3. Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

4. Click Next repeatedly until the Edit Mailbox List panel appears.

5. In the mailbox list, click the mailbox you want to modify.

6. Click Properties. A tabbed dialog appears.

7. Click the Mailbox Name tab.

8. In the Name field, type the new name of the mailbox.

9. Click OK. The Edit Mailbox List panel reappears.

10. Click Next repeatedly until the Selection Summary panel appears.

11. Click Finish.

Note

After making changes to your mailbox settings, you must advance through the wizard panels and click Finish

in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.
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Changing mailbox numbers (Mailbox system)

1.

On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.

2. Click Next when you are ready to proceed. The Call Answering panel appears.

3. Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The

System Greeting Type panel appears.

4. Click Next repeatedly until you reach the Assign Mailbox Numbers panel.

o
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9.

If you want to change the length of mailbox numbers, click the new number in the Number Of Digits In Mailbox
Number field.

In the mailbox list, click the mailbox you want to modify.
Click Assign. The Assign Mailbox Number dialog appears.
Click Allow Access When The Caller Enters, click the new mailbox number in the drop-down list and click OK.

Repeat steps #6 to #8 for each mailbox you want to renumber.

10. Click Next repeatedly until you reach the Selection Summary panel.
11. Click Finish.

Note

If you recorded a custom mailbox menu, you may need to re-record it to reflect the mailbox number

changes.
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Disabling access to a mailbox (Mailbox system)

1.
2.

w
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On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
Click Next when you are ready to proceed. The Call Answering panel appears.

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

Click Next repeatedly until you reach the Assign Mailbox Numbers panel.

In the mailbox list, click the mailbox you want to disable.

Click Assign. The Assign Mailbox Number dialog appears.

Click Do Not Allow The Caller Access and click OK. The Assign Mailbox Numbers panel reappears.
Click Next repeatedly until you reach the Selection Summary panel.

Click Finish.
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Recording a new mailbox greeting (Mailbox system)

1.
2.

w
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8.
9.

On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
Click Next when you are ready to proceed. The Call Answering panel appears.

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

Click Next repeatedly until the Edit Mailbox List panel appears.
In the mailbox list, click the voice message or fax on demand mailbox you want to modify.
Click Properties. A tabbed dialog appears.

If you are modifying a voice message mailbox, click the Greeting Type tab and click Play A Custom Greeting |
Record.

Click the Record Greeting tab.
Click the Record button.

10. After the beep, say your greeting.

11. When you are finished recording, click the Stop button.

12. Click OK. The Edit Mailbox List panel reappears.

13. Click Next repeatedly until the Selection Summary panel appears.
14. Click Finish.

Notes

To listen to your message, click the Play button.
After making changes to your mailbox settings, you must advance through the wizard panels and click Finish

in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.

If you want to re-record the greeting, click the Record button again.
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Selecting a TalkWorks mailbox greeting (Mailbox system)

1.
2.

w
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On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
Click Next when you are ready to proceed. The Call Answering panel appears.

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

Click Next repeatedly until the Edit Mailbox List panel appears.

In the mailbox list, click the voice message mailbox you want to modify.
Click Properties. A tabbed dialog appears.

Click the Greeting Type tab.

Click Play A TalkWorks Greeting.

Click the Select A TalkWorks Greeting tab.

.In the Name list, click the greeting you want to use. A script of the greeting appears in the Description section.

If you want to hear the greeting, click the Play button.

11. Click OK. The Edit Mailbox List panel reappears.

12. Click Next repeatedly until the Selection Summary panel appears.
13. Click Finish.

Note

After making changes to your mailbox settings, you must advance through the wizard panels and click Finish

in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.
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Using an existing wave file as your mailbox greeting (Mailbox system)

1.
2.

w
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8.
9.

On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
Click Next when you are ready to proceed. The Call Answering panel appears.

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

Click Next repeatedly until the Edit Mailbox List panel appears.
In the mailbox list, click the voice message or fax on demand mailbox you want to modify.
Click Properties. A tabbed dialog appears.

If you are modifying a voice message mailbox, click the Greeting Type tab and click Play A Custom Greeting |
Record.

Click the Record Greeting tab.
Click Import. The Import Greeting File dialog appears.

10. Select the wave file (.WAV) you want to use and click Open. The Record Greeting tab reappears.
11. Click OK. The Edit Mailbox List panel reappears.

12. Click Next repeatedly until the Selection Summary panel appears.
13. Click Finish.

Note

After making changes to your mailbox settings, you must advance through the wizard panels and click Finish

in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.
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Recording a new announcement (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.

2. Click Next when you are ready to proceed. The Call Answering panel appears.

w

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

Click Next repeatedly until the Edit Mailbox List panel appears.

In the mailbox list, click the announcement mailbox you want to modify.
Click Properties. A tabbed dialog appears.

Click the Greeting Type tab.
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Click Play A Custom Greeting | Record.

9. Click the Record Greeting tab.

10. Click the Record button.

11. After the beep, say your announcement.

12. When you are finished recording, click the Stop button.

13. Click OK. The Edit Mailbox List panel reappears.

14. Click Next repeatedly until the Selection Summary panel appears.
15. Click Finish.

Notes

. To listen to your recording, click the Play button.

. After making changes to your mailbox settings, you must advance through the wizard panels and click Finish
in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.

- If you want to re-record the announcement, click the Record button again.
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Using an existing wave file as your announcement (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.

2. Click Next when you are ready to proceed. The Call Answering panel appears.

w

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

Click Next repeatedly until the Edit Mailbox List panel appears.

In the mailbox list, click the announcement mailbox you want to modify.
Click Properties. A tabbed dialog appears.

Click the Greeting Type tab.
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Click Play A Custom Greeting | Record.

9. Click the Record Greeting tab.

10. Click Import. The Import Greeting File dialog appears.

11. Select the wave file (*.WAV) you want to use and click Open. The Record Greeting tab reappears.
12. Click OK. The Edit Mailbox List panel reappears.

13. Click Next repeatedly until the Selection Summary panel appears.

14. Click Finish.

Note

. After making changes to your mailbox settings, you must advance through the wizard panels and click Finish
in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.
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Selecting a TalkWorks announcement (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.

2. Click Next when you are ready to proceed. The Call Answering panel appears.

w

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

Click Next repeatedly until the Edit Mailbox List panel appears.

In the mailbox list, click the announcement mailbox you want to modify.
Click Properties. A tabbed dialog appears.

Click the Greeting Type tab.

Click Play A TalkWorks Greeting.

Click the Select A TalkWorks Greeting tab.

0. In the Name list, click the announcement you want to use. A script of the announcement appears in the
Description section. If you want to hear the announcement, click the Play button.

11. Click OK. The Edit Mailbox List panel reappears.
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12. Click Next repeatedly until the Selection Summary panel appears.
13. Click Finish.

Note

. After making changes to your mailbox settings, you must advance through the wizard panels and click Finish
in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.
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Recording a new document menu (Mailbox system)

1.
2.

w
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9.

On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
Click Next when you are ready to proceed. The Call Answering panel appears.

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

Click Next repeatedly until the Edit Mailbox List panel appears.

In the mailbox list, click the fax on demand mailbox you want to modify.
Click Properties. A tabbed dialog appears.

Click the Record Document Menu tab.

Click the Record button.

After the beep, say the document menu.

10. When you are finished recording, click the Stop button.
11. Click OK. The Edit Mailbox List panel reappears.

12. Click Next repeatedly until the Selection Summary panel appears.
13. Click Finish.

Notes

To listen to the menu, click the Play button.
After making changes to your mailbox settings, you must advance through the wizard panels and click Finish

in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.

If you want to re-record the menu, click the Record button again.
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Using an existing wave file as a document menu (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

w

Click Next repeatedly until the Edit Mailbox List panel appears.
In the mailbox list, click the fax on demand mailbox you want to modify.
Click Properties. A tabbed dialog appears.

Click the Record Document Menu tab.
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Click Import. The Import Greeting File dialog appears.

9. Select the wave file (.WAV) you want to use and click Open. The Record Document Menu tab reappears.
10. Click OK. The Edit Mailbox List panel reappears.

11. Click Next repeatedly until the Selection Summary panel appears.

12. Click Finish.

Note

- After making changes to your mailbox settings, you must advance through the wizard panels and click Finish
in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.
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Changing the remote access password (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.
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Click Next repeatedly until the Edit Mailbox List panel appears.
In the mailbox list, click the voice message or announcement mailbox you want to modify.
Click Properties. A tabbed dialog appears.

Click the Remote Access tab.
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In the Password field, type the new remote access password.

9. Click OK. The Edit Mailbox List panel reappears.

10. Click Next repeatedly until the Selection Summary panel appears.
11. Click Finish.

Note

- After making changes to your mailbox settings, you must advance through the wizard panels and click Finish
in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.



WinFax main window

Changing the greeting type (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.

2. Click Next when you are ready to proceed. The Call Answering panel appears.

3. Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.
4. Click Next repeatedly until the Edit Mailbox List panel appears.
5. In the mailbox list, click the voice message or announcement mailbox you want to modify.
6. Click Properties. A tabbed dialog appears.
7. Click the Greeting Type tab.
8. Specify the type of greeting you want to use.
- If you want to use a standard TalkWorks greeting, click Play A TalkWorks Greeting.
- If you want to record your own custom greeting, click Play A Custom Greeting | Record.
- If you want to import a wave file (.WAV) to use as a greeting, click Play A Custom Greeting | Record.
9. Specify the greeting you want to use.
" If you selected Play A TalkWorks Greeting, click the Select A TalkWorks Greeting tab and select the greeting
you want to use.
. If you selected Play A Custom Greeting | Record, click the Record Greeting tab and record your greeting or

import the greeting wave file.
10. Click OK. The Edit Mailbox List panel reappears.

11. Click Next repeatedly until the Selection Summary panel appears.
12. Click Finish.

Note

- After making changes to your mailbox settings, you must advance through the wizard panels and click Finish
in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.
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Changing the mailbox type (Mailbox system)

1.

On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.

2. Click Next when you are ready to proceed. The Call Answering panel appears.
3. Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

4. Click Next repeatedly until the Edit Mailbox List panel appears.

5. In the mailbox list, click the voice message or announcement mailbox you want to modify.

6. Click Properties. A tabbed dialog appears.

7. Click the Accept Voice Messages tab.

8. Do either of the following:
- If you want TalkWorks to record callers” messages in this mailbox, click Allow Caller To Record A Voice
Message.
- If you want to make this an announcement mailbox, click Hang Up.

9. Click OK. The Edit Mailbox List panel reappears.

10. Click Next repeatedly until the Selection Summary panel appears.

11. Click Finish.

Notes

After making changes to your mailbox settings, you must advance through the wizard panels and click Finish

in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.

Depending on the mailbox type you select, you may need to select, record or import a mailbox greeting.
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Changing document numbers (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.
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Click Next repeatedly until the Edit Mailbox List panel appears.
In the mailbox list, click the fax on demand mailbox you want to modify.
Click Properties. A tabbed dialog appears.

Click the Assign Document Numbers tab.
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If you want to change the number of digits in the document number, click the appropriate number in the
Number Of Digits In Document Number field.

9. In the document list, click the appropriate document.
10. Click Assign. The Assign Document Number dialog appears.

11. Click Allow Access When The Caller Enters, click the number in the drop-down list and click OK. The Assign
Document Numbers tab reappears.

12. Repeat steps #9 to #11 for each document you want to renumber.
13. Click the Record Document Menu tab.

14. Record a new document menu.

15. Click OK. The Edit Mailbox List panel reappears.

16. Click Next repeatedly until the Selection Summary panel appears.
17. Click Finish.

Note

- After making changes to your mailbox settings, you must advance through the wizard panels and click Finish
in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.
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Adding new documents (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.

Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.
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Click Next repeatedly until the Edit Mailbox List panel appears.

In the mailbox list, click the fax on demand mailbox you want to modify.
Click Properties. A tabbed dialog appears.

Click the Fax On Demand Documents tab.

Click Add. The Fax On Demand Document Properties dialog appears.
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Add the new document.

- In the Name field, type a name for the new fax on demand document.
- In the Description field, type text to help you identify this fax on demand document in the future.
" Click Add. The Select Files To Add To This Document dialog appears. Select the fax image files that make
up this document.
. Click OK. The Fax On Demand Documents tab reappears.
10. Click the Assign Document Numbers tab.

11. Assign a retrieval number to the new document.

- In the document list, click the document you just created.
- Click Assign. The Assign Document Number dialog appears.
" Click Allow Access When The Caller Enters, click the number in the drop-down list and click OK.

12. Click the Record Document Menu tab.

13. Specify a document menu.

. If you want to re-record a custom message to add the new document number to the menu, click the Record
button, say the menu after the beep and click Stop Recording.
. If you want to import a wave file (.WAV) containing the new menu, click Import, select the file in the Import

Greeting dialog and click OK.
14. Click OK. The Edit Mailbox List panel reappears.

15. Click Next repeatedly until the Selection Summary panel appears.
16. Click Finish.

Note

- After making changes to your mailbox settings, you must advance through the wizard panels and click Finish
in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.
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Removing documents (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.

2. Click Next when you are ready to proceed. The Call Answering panel appears.
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Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

Click Next repeatedly until the Edit Mailbox List panel appears.
In the mailbox list, click the mailbox you want to modify.

Click Properties. A tabbed dialog appears.

Click the Fax On Demand Documents tab.

In the document list, click the document you want to delete.
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Click Remove. TalkWorks deletes the document. This does not delete the fax image files associated with the
document.

10. Click the Record Document Menu tab.

11. Specify a new document menu.

. If you want to re-record a custom message to add the new document number to the menu, click the Record
button, say the menu after the beep and click Stop Recording.
. If you want to import a wave file (.WAV) containing the new menu, click Import, select the file in the Import

Greeting dialog and click OK.
12. Click OK. The Edit Mailbox List panel reappears.

13. Click Next repeatedly until the Selection Summary panel appears.
14. Click Finish.

Note

- After making changes to your mailbox settings, you must advance through the wizard panels and click Finish
in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.
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Deleting a mailbox (Mailbox system)

1. On the TalkWorks menu, click Mailbox Wizard. The TalkWorks Mailbox wizard starts.
2. Click Next when you are ready to proceed. The Call Answering panel appears.

3. Click Allow The Caller To Select From The Voice And Fax On Demand Mailboxes | Create and click Next. The
System Greeting Type panel appears.

4. Click Next repeatedly until the Edit Mailbox List panel appears.

5. In the mailbox list, click the mailbox you want to delete.

6. Click Remove. A confirmation dialog appears. Click Yes to delete the mailbox and any messages contained
within it.

7. Click OK. The Edit Mailbox List panel reappears.

8. Click Next repeatedly until the Selection Summary panel appears.

9. Click Finish.

Note

- After making changes to your mailbox settings, you must advance through the wizard panels and click Finish
in the Selection Summary panel to save your settings. Otherwise, the settings are not saved.
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Starting the Telephone from WinFax

On the TalkWorks menu, click Telephone.



Windows desktop
Starting the Telephone from CommBar

On CommBar, click the TalkWorks Telephone button.



Windows desktop
Starting the Telephone from the Windows Start menu

" On the Windows Start menu, point to Programs, then point to WinFax PRO 7.0 and click TalkWorks
Telephone.



WinFax main window

Exiting the Telephone

1. On the Telephone, click Menu. A drop-down menu appears.
2. Click Close.
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Specifying your location and related dialing options from the Telephone

On the TalkWorks menu, click Telephone. The Telephone appears.
Click Menu. A drop-down menu appears.

Click Properties. The Telephone Properties dialog appears.

Click the Dialing tab.
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Do one of the following.

The instructions provided in the topics below describe how to perform these tasks from the WinFax Dialing
Properties dialog. However, you can also perform them from the Telephone Properties dialog.

Set up a new location
Modify an existing location
Remove a location

Change the telephone number associated with a location
Bill a telephone call to a credit card

Specify pulse or touch tone dialing

Specify a long distance access code

Specify an international access code

Specify the modem you want to use

Note

- The appearance of the Dialing tab varies depending whether you set up WinFax to dial using the Windows
(TAPI) dialing method or the Delrina dialing method.
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Specifying credit card options from the Telephone

On the TalkWorks menu, click Telephone. The Telephone appears.
Click Menu. A drop-down menu appears.

Click Properties. The Telephone Properties dialog appears.

Click the Credit Cards tab.

Do one of the following.
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The instructions provided in the topics below describe how to perform these tasks from the WinFax Dialing
Properties dialog. However, you can also perform them from the Telephone Properties dialog.

* Define a new credit card for use with WinFax

* Modify credit card information
* Remove a credit card definition
* Rename a credit card definition

* Set up credit card dialing sequences
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Specifying your modem and modem-related settings from the Telephone

On the TalkWorks menu, click Telephone. The Telephone appears.
Click Menu. A drop-down menu appears.

Click Properties. The Telephone Properties dialog appears.

Click the Modems tab.

Do one of the following.
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The instructions provided in the topics below describe how to perform these tasks from the WinFax Modem
Properties dialog. However, you can also perform them from the Telephone Properties dialog.

Activate a modem

Add a new modem
Change modem setup
Switch to a different modem port

' Control your PC’s speaker volume
Specify your modem type
Specify settings for different types of telephone lines
Specify your modem initialization sequence
Specify your modem reset string
Use flow control
Specify the maximum and minimum transmission speed
Enable Error Correcting Mode (ECM) for receiving
Enable Error Correcting Mode (ECM) for sending
Enable high speed compression
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Setting redial preferences

On the TalkWorks menu, click Telephone. The Telephone appears.
Click Menu. A drop-down menu appears.

Click Properties. The Telephone Properties dialog appears.

Click the General tab.
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In the When Line Is Busy section, do either of the following:

If you want to attempt to redial a busy number for a specific period of time, click Redial For and type the
appropriate times in the Minutes and Seconds fields.

. If you want to attempt to redial a busy number for a set number of times, click Redial and type the number of
times in the field.

6. Inthe Pause For field, type the number of seconds you want to wait between attempted redials.
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Specifying the telephone call announcement sound from the Telephone

On the TalkWorks menu, click Telephone. The Telephone appears.
Click Menu. A drop-down menu appears.

Click Properties. The Telephone Properties dialog appears.

Click the General tab.
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In the Options section, do one of the following:

. In the Play This Wave File When A Call Comes In field, type the path and file name of the wave file you want
TalkWorks to play to announce an incoming telephone call.

. Click Browse, select the appropriate wave file and click Open. The General tab reappears.

Notes

TalkWorks plays the wave file each time your telephone rings. For example, if you set up TalkWorks to
answer the telephone after four rings, you hear this wave file four times for each incoming call.

- If you do not want to be notified each time TalkWorks detects an incoming call, leave this field blank.

. You can also change this setting in the TalkWorks Properties dialog.
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Playing music on hold

On the TalkWorks menu, click Telephone. The Telephone appears.
Click Menu. A drop-down menu appears.

Click Properties. The Telephone Properties dialog appears.

Click the General tab.
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In the Options section, do either of the following:

In the Play This Wave File To The Person On Hold field, type the path and file name of the wave file you
want TalkWorks to play when callers are on hold.

. Click Browse, select the appropriate wave file and click Open. The General tab reappears.
Tip

Instead of playing music to callers while they are on hold, try playing a wave file that advertises your
company’s services.

* Related Topics
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Dialing a telephone number

1. On the TalkWorks menu, click Telephone. The Telephone appears.
2. Click Dial. The Dial Telephone dialog appears.

3. Do one of the following:

" In the Country, Area and Number fields, type the phone number you want to dial.

. If you want to dial one of the most recently dialed numbers, click the number in the Recently Dialed
Numbers list.

. If you want to select the number from a WinFax phonebook, click Phonebook, click the recipient you want to

dial and click OK.
4. If you want to automatically redial the number when the line is busy, enable Redial On Busy.

5. Click Dial. The Telephone reappears and begins dialing the number.
6. Pick up your handset to talk or speak into your microphone.
7.

When your conversation is finished, replace your handset or click the release button to hang up.

Notes

- To exit the telephone and return to WinFax, click Menu and click Close.

. Depending on your hardware, you may or may not be able to hear your own voice through the speakers.
. To select a phone number from a WinFax phonebook, voice information must be included in the recipient
information.

* Related Topics
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Dialing a telephone number using the speaker phone

On the TalkWorks menu, click Telephone. The Telephone appears.
Click SPKR. The handset lifts off the telephone and you hear a dial tone.
Key the number you want to dial on your keyboard.

Speak into your microphone. Click Mute to block out sound at your end of the call.
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When your conversation is finished, click the release button to hang up.

* Related Topics



WinFax main window

Redialing a telephone number

1. On the Telephone, click Redial. The Redial Options dialog appears.
2. Click Redial Once.

Note

To always redial a busy number, set the appropriate option on the General tab of the Telephone Properties
dialog.

* Related Topics
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Defining a speed dial number

1. On the TalkWorks menu, click Telephone. The Telephone appears.

2. Click Set and then click any blank speed dial button on the right side of the Telephone. The Set Speed Dial
dialog appears.

3. In the Button Text field, type the text you want to appear on the speed dial button.
4. Do either of the following:

In the Country, Area and Number fields, type the telephone number you want to dial when you click this
speed dial button.

. Click Phonebook, select the recipient from your WinFax phonebooks and click OK.
5. Click OK. The Telephone reappears with a newly-labeled speed dial button.

Notes

If you cannot see the side panel on the Telephone, click Menu and enable Expand Telephone.
- Keep the button text short so it fits on the speed dial button.

* Related Topics
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Dialing a speed dial number

1. On the TalkWorks menu, click Telephone. The Telephone appears.

2. Click the appropriate speed dial button. TalkWorks dials the number associated with the button.

* Related Topics
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Hanging up

. On the Telephone, click the release button to hang up and return the handset receiver to its resting position.
Note

- If you are using the speaker phone, click SPKR to hang up.

* Related Topics
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Answering a call using a speaker phone

1. On the Telephone, click SPKR.

2. Speak into your microphone to begin the conversation.

Note

If the incoming call is a fax and you enabled Eavesdropping in the Receive Properties dialog, click the
release button. WinFax places the fax in the Receive Log. To display the Receive Properties dialog, click Receive on
the Setup menu.
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Starting the Answering Machine from WinFax

On the TalkWorks menu, click Answering Machine.



Windows desktop
Starting the Answering Machine from CommBar

On the CommBar, click the TalkWorks Answering Machine button.



Windows desktop
Starting the Answering Machine from the Windows Start menu

" On the Windows Start menu, point to Programs, then WinFax PRO 7.0 and click TalkWorks Answering
Machine.
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Exiting the Answering Machine

1. On the Answering Machine, click Menu. A drop-down menu appears.
2. Click Close.
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Recording a memo from the WinFax Logs window

On the Window menu, click Receive Log. The Logs window opens to display the Receive Log folder.
If you set up a custom mailbox, click the mailbox folder in which you want to record the memo.

On the TalkWorks menu, click Memo. The Record Memo dialog appears.

Click the Record button. TalkWorks plays a beep to indicate that recording has started.

After the beep, start recording your memo.

When you are finished your recording, click the Stop button.
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Do either of the following:

. If you want to listen to your recording, click the Play button.
- If you want to re-record your memo, click the Record button.
8. Click Save. TalkWorks saves the memo in the active mailbox folder.

Tips
- Use a memo to leave a recorded message or reminder in your mailbox for yourself.
- If you record a lot of memos, add the memo button to the AudioBar. To display AudioBar properties, right
click on the AudioBar and then click Properties.

* Related Topics
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Recording a memo from the Answering Machine

On the TalkWorks menu, click Answering Machine. The Answering Machine appears.
In the Mailbox drop-down list, click the mailbox in which you want to record the memo.
Click Memo. The Record Memo dialog appears.

Click the Record button. TalkWorks plays a beep to indicate that recording has started.
After the beep, start recording your memo.

When you are finished your recording, click the Stop button.
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Do either of the following:

. If you want to listen to your recording, click the Play button.
- If you want to re-record your memo, click the Record button.
8. Click Save. TalkWorks saves the memo in the active mailbox folder.

Tip

Use a memo to leave a recorded message or reminder in your mailbox for yourself.

* Related Topics
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Recording a mailbox greeting from the Answering Machine

1. On the TalkWorks menu, click Answering Machine. The Answering Machine appears.

2. In the Mailbox drop-down list, click the mailbox for which you want to record a greeting.
3.
4

. Select the greeting you want TalkWorks to use to answer the telephone.

Click Greet. The TalkWorks Greeting wizard starts.

If you want to use one of the provided greetings, click Play A TalkWorks Greeting and click Next. The Select

A TalkWorks Greeting panel appears. In the Name list, select the greeting you want to use. The script of the greeting
appears in the Description section. To hear the greeting, click the Play button.

If you want to record your own greeting, click Play A Custom Greeting | Record and click Next. The Record

Greeting panel appears. Click the Record button and say your message after the beep. Click the Stop button when
you are finished.

If you want to use an existing wave file (.WAV) as your greeting, click Play A Custom Greeting | Record and

click Next. The Record Greeting panel appears. Click Import, select the wave file you want to use in the Import
Greeting File dialog and click Open. The Greeting Type panel reappears.
5. Click Finish.

* Related Topics
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Playing a voice message or memo from the WinFax Logs window

1. On the Window menu, click Receive Log. The Logs window opens to display the Receive Log folder.
2. If you set up multiple mailboxes, click the appropriate mailbox folder.

3. Inthe event list, double click the voice message you want to play.
Tips

- To play all new messages in the mailbox, click the Play New Messages button on the AudioBar.
. Use the AudioBar at the bottom of the Logs window to play all new messages, rewind and fast forward
messages, and adjust the volume.

* Related Topics
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Playing a voice message or memo from the Answering Machine

1. On the TalkWorks menu, click Answering Machine. The Answering Machine appears.
In the Mailbox drop-down list, click the mailbox containing the messages you want to play.

3. Click the Play button. The Answering Machine announces the number of new and old messages in the
mailbox and then begins playing the messages.

4. During playback, you can do any of the following:

. To stop playback, click the Stop button.
" To delete the current message, click the Delete button.
" To rewind four seconds, click the Rewind button.
- To fast forward four seconds, click the Fast Forward button.
- To go to the next message, click the Next button.
- To go to the previous message, click the Previous button.
Tip
. Adjust your modem and Windows 95 volume controls for optimum sound quality.
Notes
. Check the call display screen during message playback for the date and time the message was left.
. TalkWorks plays new messages first and then old messages. Unplayed voice messages are indicated by the

count in the New box. Previously played voice messages are indicated by the count in the Old box. Once a new
message is played, it becomes an old message.
- The default mailbox is the Receive Log.

* Related Topics



Calling in to change your password

1. Using a touch tone telephone, dial your modem number. TalkWorks answers the call and plays a greeting.
2. On the telephone keypad, press the asterisk key (*). TalkWorks detects that you are a mailbox owner.

3. If there are multiple mailboxes, TalkWorks prompts you to enter your mailbox number. On the telephone
keypad, press your mailbox number. TalkWorks prompts you to enter your password.

4. On the telephone keypad, press the two digits that make up your password. TalkWorks plays a message
prompting you to specify what you want to do.

5. Press 7. TalkWorks prompts you to enter your new password.

6. On the telephone keypad, press the two digits you want to use as your password. TalkWorks prompts you to
enter your new password again.

7. On the telephone keypad, press the two digits you want to use as your password. TalkWorks informs you that
your password has been changed.
Tip
- For maximum security, change your password regularly.
Note

. You must enter the numbers of your password within one second of each other. If you wait longer, TalkWorks
prompts you again to enter your password, up to three times and then hangs up.

* Related Topics



Calling in for voice messages

1. Using a touch tone telephone, dial your modem number. TalkWorks answers the call and plays a greeting.
2. On the telephone keypad, press the asterisk key (*). TalkWorks detects that you are a mailbox owner.

3. If there are multiple mailboxes, TalkWorks prompts you to enter your mailbox number. On the telephone
keypad, press your mailbox number. TalkWorks prompts you to enter your password.

4. On the telephone keypad, press the two digits that make up your password. TalkWorks plays a message
prompting you to specify what you want to do.

5. Press 1. TalkWorks announces the number of messages in the mailbox and begins playing the first new
message.

6. Do one of the following:

To replay the message, press 1.

To mark the message as old, press 2.
To remove the message, press 3.

To play the previous message, press 5.
To play the next message, press 6.

Note

. You must enter the numbers of your password within one second of each other. If you wait longer, TalkWorks
prompts you again to enter your password, up to three times and then hangs up.

* Related Topics



Calling in to record your mailbox greeting

1. Using a touch tone telephone, dial your modem number. TalkWorks answers the call and plays a greeting.
2. On the telephone keypad, press the asterisk key (*). TalkWorks detects that you are a mailbox owner.

3. If there are multiple mailboxes, TalkWorks prompts you to enter your mailbox number. On the telephone
keypad, press your mailbox number. TalkWorks prompts you to enter your password.

4. On the telephone keypad, press the two digits that make up your password. TalkWorks plays a message
prompting you to specify what you want to do.

5. Press 8. TalkWorks prompts you to begin recording your message and then plays a beep.

6. Say your mailbox greeting and press the number sign (#) when you are finished.

Notes

- If you are using one of the supplied TalkWorks mailbox greetings, you cannot record your mailbox greeting
over the telephone.

. You must enter the numbers of your password within one second of each other. If you wait longer, TalkWorks
prompts you again to enter your password, up to three times and then hangs up.

* Related Topics



Calling in for fax messages

1. Using a touch tone telephone, dial your modem number. TalkWorks answers the call and plays a greeting.
2. On the telephone keypad, press the asterisk key (*). TalkWorks detects that you are a mailbox owner.

3. If there are multiple mailboxes, TalkWorks prompts you to enter your mailbox number. On the telephone
keypad, press your mailbox number. TalkWorks prompts you to enter your password.

4. On the telephone keypad, press the two digits that make up your password. TalkWorks plays a message
prompting you to specify what you want to do.

5. Follow the prompts.

Note

- You must enter the numbers of your password within one second of each other. If you wait longer, TalkWorks
prompts you again to enter your password, up to three times and then hangs up.

* Related Topics
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Deleting a voice message from the WinFax Logs window

1. On the Window menu, click Receive Log. The Logs window opens to display the Receive Log folder.
2. If you set up a custom mailbox, click the mailbox folder containing the message you want to delete.
3. Inthe event list, click the voice message you want to delete.

4. On the Edit menu, click Remove.

Tip

You can also delete the selected message by clicking the Delete button on the AudioBar at the bottom of the
WinFax window.
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Deleting a voice message from the Answering Machine

1
2
3.
4

. On the TalkWorks menu, click Answering Machine. The Answering Machine appears.

In the Mailbox drop-down list, click the mailbox folder containing the voice message you want to delete.
Click the Play button.

. When you hear the message you want to delete, click the Delete button.
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Adding a voice recipient to a phonebook

o

. On the Window menu, click Phonebooks. The Phonebooks window opens.

1
2. In the phonebooks list, click the phonebook to which you want to add a recipient.
3.
4

On the File menu, point to New and click Recipient. The New Recipient dialog appears.

. Click the Name and Number tab and fill in the fields with the new recipient’s name, company and telephone

numbers.

Click the Address tab and specify the recipient’s address.

6. If you want to make notes about this recipient, click the General tab and type the appropriate text.

7. Click the remaining tabs in the New Recipient dialog and select any other appropriate options.

Tip

For help on an item in the New Recipient dialog, click ? at the top of the dialog and click the item.

Notes

You can also add recipients to a phonebook in the Phonebooks section of the Send dialog.
The number of records a phonebook or group can contain is limited only by the available disk space.
You cannot add recipients to a read-only phonebook from within WinFax.



Leaving a message in a mailbox

1. Dial the fax number of the computer on which TalkWorks is installed.

2. If Automatic Receive and Voice Answering are enabled, TalkWorks answers the call when the telephone rings
and no one picks up the telephone handset.

If prompted, press the mailbox number in which you want to leave a message.
4. TalkWorks plays the mailbox greeting followed by a beep to indicate the beginning of recording.

5. Say your message and press the number sign (#) when you are finished. TalkWorks plays a message review

prompt.

6. Do one of the following:
- To review your message, press 1.
- To re-record your message, press 2.
- To quit, press the number sign (#) or hang up.

Notes
- WinFax receives calls and faxes through the telephone line connected to your modem. Callers use the same
telephone number to send a fax or select a mailbox and leave a voice message.
. Both Automatic Receive and Voice Answering must be enabled for TalkWorks to answer voice calls. If voice
answering is not enabled, the caller hears a high-pitched fax signal and cannot leave a voice message.
- To automatically receive events with the Automatic Receive you must be running (either as a normal or

minimized window) one of WinFax, CommBar, TalkWorks Answering Machine or TalkWorks Telephone.



Tell me about AudioEditor

Use TalkWorks AudioEditor to record and modify greetings, voice message and wave files. Create or
modify files to be played to callers on hold and system notification wave files. Delete background noise
and stretches of silence or change the order of segments of the wave file. Use special effects to create
an echo or fade out.



AudioEditor
Starting AudioEditor from the Windows Start menu

On the Windows Start menu, point to Programs, then to WinFax PRO 7.0 and click TalkWorks AudioEditor.
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Starting AudioEditor from WinFax
On the TalkWorks menu, click AudioEditor.



AudioEditor
Exiting AudioEditor

On the File menu, click Exit.



AudioEditor
Specifying the scale used to display audio recordings

On the View menu, point to Scale and click the appropriate scale option.



AudioEditor
Zooming in and out in the lower audio panel

On the View menu, point to Zoom and click the appropriate zoom option.



AudioEditor
Adjusting volume controls

1. On the View menu, click Volume Controls. The Volume Control dialog appears.

2. Adjust the volume as required.



AudioEditor
Opening an audio file

1. On the File menu, click Open. The Open dialog appears.

2. Select the wave file (.WAV) you want to open and click Open. AudioEditor loads the selected file for editing.



AudioEditor
Creating an audio file

1. On the File menu, click New. AudioEditor loads a new workspace.

2. On the Player menu, click Record. The word Recording flashes on the status bar to indicate that recording is
in progress.

Say your message into your microphone.
On the Player menu, click Stop. Recording stops.
Edit the recording as required.

On the File menu, click Save As. The Save As dialog appears.

N o g ke

Select the path in which you want to install the file, type the file name and click Save.



AudioEditor
Viewing file information

On the Options menu, click File Info. The File Info dialog appears.



AudioEditor
Saving an audio file

On the File menu, click Save.



AudioEditor
Recording a message

1. On the Player menu, click Record. The word Recording flashes on the status bar to indicate that recording is
in progress.
2. Say your message into your microphone.

3. On the Player menu, click Stop. Recording stops.

Note

. A representation of the entire recording appears in the upper audio pane. The lower pane displays a
maghnified representation of a portion of the recording.



AudioEditor

Enabling record mode

1.

On the Player menu, click Record. The word Recording flashes on the status bar to indicate that recording is
in progress.

2. Say your message into your microphone.



AudioEditor
Pausing during playback

On the Player menu, click Pause. Playing halts until you click Play on the Player menu.



AudioEditor
Disabling record mode

On the Player menu, click Stop. Recording stops.



AudioEditor
Playing an entire recording

On the Player menu, click Play. AudioEditor plays back the message for you.



AudioEditor
Playing a segment of a recording

1. In the audio pane, click the desired start point and hold the left mouse button down.
2. Drag the mouse to highlight the segment you want to play.

3.
4

Release the mouse button.

. On the Player menu, click Play. AudioEditor plays back the selected segment of the message.



AudioEditor
Inserting another message in the middle of a recording

1. In the audio pane, click the desired insertion point.
2. On the Player menu, click Record.

3. Say your message into your microphone.

4

. On the Player menu, click Stop. Recording stops. AudioEditor inserts the new message into the recording at
the specified insertion point.

Tip

Edit the recording to eliminate any silences around the inserted segment.



AudioEditor
Re-recording a segment of a recording

1. In the audio pane, click the beginning of the segment you want to re-record and hold the left mouse button
down.
Drag the mouse to highlight the segment you want to re-record.
Release the mouse button.

4. On the Player menu, click Record. The word Recording flashes on the status bar to indicate that recording is
in progress.

5. Say your message into the microphone.

6. On the Player menu, click Stop. Recording stops. AudioEditor overwrites the selected segment with the new
recording.



AudioEditor
Rewinding a recording

On the Player menu, click Rewind. AudioEditor rewinds four seconds of the message.



AudioEditor
Going to the end of a recording

On the Player menu, click Go To End. AudioEditor goes to the end of the message.



AudioEditor
Adding fading effects to a recording

1. Select the segment of the audio file you want to modify.

2. On the Effects menu, point to Fade and click In or Out.



AudioEditor
Controlling the volume of a recording

1. Select the segment of the audio file you want to modify.

2. On the Effects menu, point to Volume and click the appropriate volume option.



AudioEditor
Adding an echo to a recording

1. Select the segment of the audio file you want to modify.

2. On the Effects menu, point to Echo and click the type of echo you want to add.



AudioEditor
Changing recording speed

1. Select the segment of the audio file you want to modify.

2. On the Effects menu, point to Speed and click the appropriate adjustment option.



AudioEditor
Trimming extra silence from a recording

On the Effects menu, click Trim Silence.



AudioEditor
Setting the sound quality

1. On the Options menu, click Record Settings. The Record Settings dialog appears.

2. In the Name drop-down list, click the appropriate quality option.

Note

Changes to the record settings take effect on the next new audio file you create. To change the format of the
loaded audio file, save the file and convert it.



AudioEditor
Setting the recording format

1. On the Options menu, click Record Settings. The Record Settings dialog appears.
2. In the Name drop-down list, click the quality level you want to produce for your recording.

3. Inthe Format drop-down list, click the appropriate option.



AudioEditor
Setting recording attributes

1. On the Options menu, click Record Settings. The Record Settings dialog appears.
2. In the Attributes drop-down list, click the appropriate option.



AudioEditor
Tuning recording performance

1. On the Options menu, click Tune Performance. The Tune Performance dialog appears.

2. In the Recording section, click the option that best describes your computer.

If you are using a 486 or Pentium processor, click Fast Computer. AudioEditor compresses your voice files
while you record them and play them back.

. If you are using a 486 or Pentium processor with a fast disk, click Fast Computer, Fast Disk. AudioEditor
compresses your voice files in a buffer while you record them.

. If you are using a 386 processor, click Slower Computer. AudioEditor compresses your voice files after you
finish recording them and playing them back.

Note

The speed of your computer determines whether AudioEditor compresses voice wave files during or after
recording and playback. TalkWorks detects your processor speed during installation, and sets wave compression
accordingly.



AudioEditor
Tuning playback performance

1. On the Options menu, click Tune Performance. The Tune Performance dialog appears.

2. In the Playback section, click the option that best describes your computer.

If you are using a 486 or Pentium processor, click Faster Computer. AudioEditor compresses your voice files
while you record them and play them back.

. If you are using a 386 processor, click Slower Computer. AudioEditor compresses your voice files after you
finish recording them and playing them back.

Note

The speed of your computer determines whether AudioEditor compresses voice wave files during or after
recording and playback. TalkWorks detects your processor speed during installation, and sets wave compression
accordingly.



AudioEditor
Undoing the last action

On the Edit menu, click Undo.



AudioEditor
Cutting a segment out of an audio file

1. Select the segment you want to remove in the upper audio pane.
2. On the Edit menu, click Cut.



AudioEditor
Copying a segment of an audio file

1. Select the segment you want to copy in the upper audio pane.

2. On the Edit menu, click Copy.



AudioEditor
Pasting a segment from the Clipboard into an audio file

1. In the upper audio pane, position the cursor at the desired insertion point.

2. On the Edit menu, click Paste. The contents of the Clipboard appear inserted at the cursor position.



AudioEditor
Pasting another audio file into the loaded audio file

1. In the upper audio pane, position the cursor at the desired insertion point.

2. On the Edit menu, click Paste From. The Open dialog appears.

3. Select the wave file you want to insert and click Open. The contents of the selected wave file appear at the
cursor position.



AudioEditor

Deleting a segment from an audio file

1. In the upper audio pane, select the segment you want to delete.

2. On the Edit menu, click Delete.



AudioEditor
Selecting the entire audio file

On the Edit menu, click Select All.



AudioEditor
Viewing and hiding the toolbar

On the View menu, enable Toolbar.
Note

To remove the toolbar from sight, on the View menu, disable Toolbar.



AudioEditor
Viewing and hiding the status bar

On the View menu, enable Status Bar.
Note

To remove the status bar from sight, on the View menu, disable Status Bar.
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Using the toll saver feature

1. On the Setup menu, click Receive. The Receive Properties dialog appears.
2. Click the Voice tab.

3. Enable Toll Saver.

Notes

- Use this option to identify if you have new messages when you call in from an outside line. If there are no
new messages, your phone will ring two more times than it normally would if TalkWorks were answering the call,
giving you time to hang up.

- The toll saver feature only detects new messages in the Receive Log. If you set up a multiple mailbox
system you cannot use the toll saver feature.
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Screening calls

1. On the Setup menu, click Receive. The Receive Properties dialog appears.
2. Click the Voice tab.

3. Enable Call Screening.

Notes

Use this option to hear callers on your speaker as they leave voice messages. You can then decide whether
to pick up each call or let TalkWorks continue to record the message.

. You can only screen your calls if your hardware supports call screening.
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Using the eavesdropping feature

1. On the Setup menu, click Receive. The Receive Properties dialog appears.
2. Click the Voice tab.

3. Enable Eavesdropping.

Note

When this option is enabled, WinFax detects and takes over an incoming fax call, even if you pick up the
handset first.
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Enabling call discrimination

. On the Setup menu, click Receive. The Receive Properties dialog appears.
. Click the General tab.

1
2
3. In the Call Discrimination section, enable Direct Data Calls To An Available Data Communications Program.
4. Do the following:

. Run or minimize WinComm in host mode.
. Run or minimize WinFax with Automatic Receive enabled.

Notes

This option is only available if you are using a Class 1, Windows (TAPI) modem that supports call
discrimination.

" For fax and data, call discrimination is automatic when Direct Data Calls To An Available Data
Communications Program is enabled.

" If Voice Answering is enabled in WinFax, the caller must also specify that they want to connect in data mode
by adding the suffix: “,,,*,,9*” to their dial string when sending files. If you have multiple mailboxes set up in
TalkWorks, insert any valid mailbox number before the 9: «,,,*,,1,,9*”. Each comma represents a two-second pause.
You may need to adjust the number of commas.



Putting a call on hold
On the Telephone, click Flash. TalkWorks puts the current line on hold.
Note

You can only put a call on hold if you subscribe to a call waiting service through your telephone company.



Starting CommBar
On the Windows Start menu, point to Programs, point to WinFax PRO 7.0 and click CommBar.



Showing CommBar

1. In the right corner of the Windows Taskbar, right click on the CommBar icon.

2. On the submenu, enable Show CommBar. CommBar appears on your screen.



Receiving events automatically with CommBar

1.

o &~ N

Enable Automatic Receive. Do one of the following:

On the Receive menu, enable Automatic Receive.
On the Answering Machine, click Menu and then enable Automatic Receive.
Right click on CommBar. A menu appears.

Click Options. The CommBar Options dialog appears.
Click the WinFax tab.

Enable Use CommBar To Receive Faxes Automatically.



Displaying call progress with CommBar (TalkWorks)

1. Click the right mouse button on the CommBar and click Options. The CommBar Options dialog appears.
2. Click the Status tab.

3. Enable Automatically Display Communications Status.

Note

. When a call is received, the CommBar status display panel appears. To take the call, click Answer. To have
TalkWorks record a message, click Take Message or wait for automatic receive if it is enabled. To stop the call, click
Cancel.



Positioning CommBar

1. Click CommBar to give it focus.

2. Drag CommBar where you want it—either docked to at the top or bottom edge of your screen or floating on
the desktop.

Note

. When you dock CommBar along the top or bottom edge of your screen, Windows rearranges your desktop
so CommBar does not cover anything else.



Enabling Auto Hide mode

1. Right click on CommBar. A menu appears.
2. On the menu, point to Bar Styles and click Auto Hide. CommBar appears as a thin line, just visible on the
screen. To redisplay it, point to the line with the mouse pointer.
Note
You can also enable and disable this setting in the CommBar Options dialog.



Modem considerations

TalkWorks supports voice modems that are compatible with Rockwell or Cirrus Logic chipsets. Your
modem may or may not have the following features:

Caller ID

Data call discrimination

Microphone

Speaker

Telephone set

Speaker phone

Hands-free phone
If your modem does not support features such as speaker phone or Caller ID, those features will not
appear in TalkWorks. Refer to your hardware documentation to determine the capabilities of your
modem.

Sound quality and availability of voice options depend on the hardware you are using. Best results will
be obtained using a multi-function modem card that includes sound and telephony or a voice modem
with speaker phone capabilities. You may find that sound quality is better through your computer
sound card than through your modem. Adjust your modem settings and your Windows 95 volume
controls to make full use of your modem features.

Obtaining a Modem List

Telephony is an emerging technology and new voice modems are being released onto the market
regularly. You can obtain a current list of modems that have been tested with TalkWorks by calling the
Delrina Fax InfoLine at:

(416) 443-1614
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Forwarding voice messages

1. On the Window menu, click Receive Log. The Logs window opens to display the Receive Log folder.
2. If you set up multiple mailboxes, click the mailbox containing the message you want to forward.

3. On the Send menu, click Forward. A confirmation dialog appears to inform you that the voice message will be
forwarded as a binary file attachment. Confirm that the recipient will be able to receive and play the message
and click OK to continue. The Send dialog appears.

4. Address the fax.
5. Inthe text area, type a message.
6. Click Send.






